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From the desk of Charles Brewer……..

Dear New User,

Welcome to MindSpring!  We want to do all we can to make sure your experience with MindSpring 
and the Internet is both productive and fun.  Have at it!  I think you’ll find that the Internet is a 
fantastic resource, and that your MindSpring account provides an ideal way to connect to that 
resource.

This starter kit is an important part of our product, and I hope it will help you get off to a fast start.  
We’ve pre-configured your software so it should be totally set up and ready to run.  We’ve even 
loaded in a set of “bookmarks” in your World Wide Web browser, which we hope will give you an 
interesting first look at some Internet resources.

We are trying to build a different and better kind of company here at MindSpring.  Please have a 
look at our Core Values and Beliefs - you’ll find them linked to our home page on the World Wide 
Web under About MindSpring.  These nine items describe the kind of performance and behavior to 
which we are aspiring.  If you don’t think we are living up to those values, let us know.  Of course, if
you do think we are living up to them, you can let us know that too.J

I do hope you’ll be delighted with your experience here, and if you are pleased with MindSpring, 
please help spread the word.  We’ll give you a $10 credit on your bill for any of our service plans 
other than the Light for each new customer who names you as the source of their referral when they 
sign up.  We are steadily expanding the scope of our network, and we’d love it if you could help 
spread the word about MindSpring to your friends and relatives.

We’ll be keeping up with the Internet technology and developments, so keep an eye on our 
announcements for word on new features and enhancements to your MindSpring service.  If you have
any ideas on how we can improve our service, we’d love to hear them!  Please e-mail them to 
suggest@mindspring.com.

Thank you for joining us.

Cheers,

Charles Brewer
MindSpring Founder and CEO





Contents

Introduction
Overview of the User's Guide......................................................................................................

How To Find Information for Your Computer Platform..............................................
How the Guide Is Organized..........................................................................................
Typographic Conventions..............................................................................................
Need Help?.....................................................................................................................

MindSpring Services
Getting to Know MindSpring.......................................................................................................

The MindSpring Core Values and Beliefs.....................................................................
MindSpring's Internet Services....................................................................................................

Dial-Up Accounts...........................................................................................................
Web Hosting Services....................................................................................................

MindSpring's Support Commitment.............................................................................................
MindSpring's Support Policy.........................................................................................
Contacting MindSpring Support....................................................................................

MindSpring's Appropriate Use Policy..........................................................................................
Statement of Policy........................................................................................................
E-mail.............................................................................................................................
News...............................................................................................................................
Internet Relay Chat (IRC)..............................................................................................
General...........................................................................................................................
Financial.........................................................................................................................
Bandwidth and Disk Utilization....................................................................................
Privacy............................................................................................................................
Account Security............................................................................................................

Netiquette......................................................................................................................................
Netiquette Guidelines.....................................................................................................
The Ten Commandments of Computer Ethics..............................................................
Additional Netiquette Information................................................................................

Installing the Software
Before You Install........................................................................................................................

Read the Service Agreement..........................................................................................
Review the Read Me File...............................................................................................
Minimum System and Software Requirements.............................................................
About the PipeLine+ Installation...................................................................................

MindSpring User's Guide Contents · i



Running Setup for PipeLine+ – Windows 3.1 and 3.11..............................................................
Running Setup for PipeLine+ – Windows 95..............................................................................
Running the Installer for PipeLine+ – Macintosh.......................................................................
Internet Applications Installed.....................................................................................................

A Notice about Licensed Products and Shareware.......................................................
Configuring Multiple Mailboxes..................................................................................................

Setting Up Multiple Mailboxes for Windows 3.1 and 3.11..........................................
Setting Up Multiple Mailboxes for Windows 95..........................................................
Setting Up Multiple Mailboxes for Macintosh..............................................................

Getting Started
Using the PipeLine+ Access Panel (Windows)...........................................................................

Connecting to the Internet (Windows)..........................................................................
The PipeLine+ Configuration Screens (Windows).......................................................

Configuring the Windows 95 Dialer............................................................................................
Adding the Dial-Up Networking Component................................................................
Setting Up Windows 95 for TCP/IP..............................................................................
Setting Up Dial-Up Networking....................................................................................
Configuring the MindSpring Dial-Up Networking Connection....................................
Logging In to MindSpring.............................................................................................

Using the PipeLine+ Access Panel (Macintosh)..........................................................................
Adding the MindSpring’s PipeLine+ Icon to the Menu................................................
Connecting to the Internet (Macintosh).........................................................................
The PipeLine+ Configuration Screens (Macintosh)......................................................

The Netscape Navigator Software
Using Netscape Navigator (Macintosh only)...............................................................................

Launching Netscape Navigator......................................................................................
Getting Started................................................................................................................
Using The Toolbar Buttons............................................................................................
FAQs about Netscape Navigator....................................................................................
Finding Help and Reference Information......................................................................

The Microsoft Internet Explorer Software
Using Microsoft Internet Explorer (Windows only)....................................................................

Launching Microsoft Internet Explorer.........................................................................
Getting Started................................................................................................................
FAQs about Microsoft Internet Explorer.......................................................................
Finding Help and Reference Information......................................................................

The Eudora Light Software
Using Eudora Light (for Windows).............................................................................................

Launching Eudora Light (Windows).............................................................................
Getting Started................................................................................................................
Using the Main Window Toolbar (Windows)...............................................................
FAQs about Eudora (Windows).....................................................................................
Finding Help and Reference Information (Windows)...................................................

Using Eudora Light (for Macintosh)............................................................................................
Launching Eudora Light (Macintosh)...........................................................................
Getting Started................................................................................................................
FAQs about Eudora (Macintosh)...................................................................................
Finding Help and Reference Information (Macintosh).................................................

Windows Internet Applications



MindSpring User's Guide MindSpring Services · iii

Using Free Agent..........................................................................................................................
Launching Free Agent....................................................................................................
Getting Started................................................................................................................
Finding Help and Reference Information......................................................................

Using WS_FTP.............................................................................................................................
Launching WS_FTP.......................................................................................................
Getting Started................................................................................................................
Finding Help and Reference Information......................................................................

Using mIRC..................................................................................................................................
Launching and Configuring mIRC................................................................................
Getting Started................................................................................................................
IRC Server Connectivity................................................................................................
IRC Tips.........................................................................................................................
Finding Help and Reference Information......................................................................

Using EWAN / Telnet..................................................................................................................
Launching and Logging on with Telnet........................................................................
Finding Help and Reference Information......................................................................

Using LView Pro..........................................................................................................................
Launching LView Pro....................................................................................................
Getting Started................................................................................................................
Finding Help and Reference Information......................................................................

Using Wincode.............................................................................................................................
Launching Wincode.......................................................................................................
Getting Started................................................................................................................
FAQs about Wincode.....................................................................................................
Finding Help and Reference Information......................................................................

Using WinZip...............................................................................................................................
Launching and Using WinZip........................................................................................
Finding Help and Reference Information......................................................................

Macintosh Internet Applications
Using NewsWatcher.....................................................................................................................

Launching NewsWatcher...............................................................................................
Getting Started................................................................................................................
Finding Help...................................................................................................................

Using Anarchie.............................................................................................................................
Launching Anarchie.......................................................................................................
Getting Started................................................................................................................
Finding Help...................................................................................................................

Using Homer.................................................................................................................................
Launching Homer...........................................................................................................
Getting Started................................................................................................................
FAQs about Homer........................................................................................................
Finding Help...................................................................................................................

Using Fetch...................................................................................................................................
Launching Fetch.............................................................................................................
Getting Started................................................................................................................
Finding Help...................................................................................................................



Using StuffIt Expander.................................................................................................................
Launching StuffIt Expander...........................................................................................
Getting Started................................................................................................................
FAQs about StuffIt Expander.........................................................................................
Finding Help and Product Information..........................................................................

Using JPEGView..........................................................................................................................
Launching JPEGView....................................................................................................
Getting Started................................................................................................................
Finding Help...................................................................................................................

Using SoundMachine....................................................................................................................
Launching SoundMachine.............................................................................................
Getting Started................................................................................................................
FAQ about SoundMachine.............................................................................................
Finding Help...................................................................................................................

Glossary of Terms

Service Agreement



Introduction

Welcome to the MindSpring family of Internet users!  

About This Guide
This User's Guide provides comprehensive, easy-to-use instructions on installing and using the 
PipeLine+ software and other MindSpring products and services.  
If you are a new Internet user, this guide includes step-by-step instructions for installing the software 
and walks you through each of the products you will use to access and explore the benefits of the 
Internet.  
If you are an experienced Internet user, the information in the guide is organized so that you may 
read only the parts of interest to you.
The following section:

· Outlines the contents of the guide

· Specifies the platforms supported 

· Illustrates how to recognize information specific to your computer platform

· Explains the typographic conventions used throughout the guide
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Overview of the User's Guide
The User's Guide explains how to install, configure, and connect to the Internet 
using your PipeLine+ software.  It also explains how to browse the World Wide 
Web, use e–mail, read newsgroups, and explore other Internet resources.  

How To Find Information for Your Computer Platform
The User's Guide includes information for Windows (Versions 3.1 and 3.11), 
Windows 95, and Macintosh users.  Much of the information is common to all 
three platforms.  When information is different from one platform to another, the 
heading that precedes the information identifies the platform, as shown in the 
following examples:
· Sending a Message (Windows)
· Sending a Message (Macintosh)

How the Guide Is Organized
The following is a general outline of the chapters and associated topics covered:
· Chapter 1 - MindSpring Services, contains an overview of our services as well

as our technical support policies, technical support contact information, 
and appropriate Internet use and privacy issues.

· Chapter 2 - Installing the Software, explains how to install the PipeLine+ 
software package.

· Chapter 3 - Getting Started, describes the PipeLine+ Access Panel and how to 
connect to MindSpring.

· Chapter 4 - Using the Netscape Navigator Software, describes how to use the 
basic functions of the web browser, including descriptions of the toolbar, 
buttons, and menu options.  Netscape Navigator is included in the 
Macintosh version of your PipeLine+ software 

· Chapter 5 - Using the Microsoft Internet Explorer Software, describes how to
use the basic functions of the web browser, including descriptions of the 
toolbar, buttons, and menu options.  Internet Explorer is included in the 
Windows and Windows 95 versions of the PipeLine+ software.

· Chapter 6 - Using Eudora Light, explains how to use the Eudora Light toolbar
and how to send and receive e-mail messages.  Eudora Light is included in
both the Windows and Macintosh versions of your PipeLine+ software.  
However, the differences between the Eudora Light for Windows and 
Macintosh are significant.  For your convenience, the information included
in this chapter is separated into two sections, one section for Windows 
users and another for Macintosh users.

· Chapter 7 - Windows Internet Applications, describes the Windows Internet 
applications included in the PipeLine+ software package.  For a complete 
list of the Windows software products, refer to Internet Applications 
Installed on 
page 31.

· Chapter 8 - Macintosh Internet Applications, describes the Macintosh Internet
applications included in the PipeLine+ software package.  For a complete 
list of the Macintosh software products, refer to Internet Applications 
Installed on page 31.

· Glossary - defines relevant Internet terms.

Note:  Information contained in this manual may change at any time.  Check 
MindSpring's web page (http://www.mindspring.com/) and the 
mindspring.announce newsgroup for current information about policies, accounts,
pricing, and how to contact us.  



Typographic Conventions
The following typographic conventions are used in this guide:

Courier This typeface represents anything you must type.  For 
example, type a:\setup.

Initial Caps Bold Words that appear in initial caps, boldface represent 
buttons, icons, and menu options, or any object that you 
click on to cause the software to perform a task.  For 
example, the Send button or the File | Open option.

italics Italics are used to emphasize certain words, especially 
new terms when they are first introduced, such as 
Uniform Resource Locator (URL).  

lowercase bold Lowercase bold distinguishes URLs, also referred to as 
Internet addresses.  For example, 
http://www.mindspring.com/.

Note: This signifies important additional information.
Notice: This advises the user about certain legal obligations 

related to the use of licensed and shareware products.
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Need Help?
If you have questions while using the Macintosh version of the PipeLine+ software,
you can find help by selecting PipeLine+ Help from the /  menu.
If you have questions while using the Windows versions of the PipeLine+ software,
you can find the information you need in the online help available directly from 
within the PipeLine+ Access Panel.  The information in the online help is both 
descriptive and instructive.  That is, instead of merely stating the choices available,
the online help guides you in making the correct choice.

What's Next?
Chapter 1 – MindSpring Services describes MindSpring's various Internet access 
account types, technical support policies and contact information, usage policies, 
and privacy issues.  We recommend that you read Chapter 1 before you install the 
PipeLine+ software.



Chapter 1
MindSpring Services

This chapter acquaints you with MindSpring Enterprises and describes MindSpring's:

· Internet access account types

· Support policies and contact information

· Usage policy and privacy issues

Chapter Table of Contents
This chapter includes the following sections:

Section Page
Getting to Know MindSpring 6
The MindSpring Core Values and Beliefs 6
MindSpring's Internet Services 7
Dial-Up Accounts 7
Web Hosting Services 8
MindSpring's Support Commitment 10
MindSpring's Support Policy 10
Contacting MindSpring Support 11
MindSpring's Appropriate Use Policy 13
Statement of Policy 14
Netiquette 17



Getting to Know MindSpring
Let us take this opportunity to tell you a little about our beginning, our officers, and
our values.
MindSpring Enterprises, Inc., is a national Internet service provider, headquartered 
in Atlanta, Georgia.  MindSpring began offering Internet access services in June 
1994 to the Atlanta metro area.  Since then, MindSpring has grown from a regional 
to a national Internet service provider.  Please check our web page, 
http://www.mindspring.com/, for the most recent update on our city locations.  
MindSpring is committed to providing licensed Internet access and superior 
technical support to each of its customers.
The principles/officers of the company are:
Charles Brewer, founder of MindSpring and chairman and chief executive officer, 
grew up in Kentucky and graduated Phi Beta Kappa from Amherst College in 
economics.  Upon graduation, Charles moved to California to work in sales for 
investment bank, Wertheim & Company.  Charles completed his MBA from 
Stanford and relocated to Atlanta.  After four years as CFO and then CEO of 
AudioFax, Charles began MindSpring Enterprises.
Michael McQuary, president and chief operating officer, is a University of Virginia
graduate with an MBA from Pepperdine University.  Mike spent 11 years with 
Mobil Chemical prior to joining MindSpring Enterprises.
Since November 1994, ITC Holding Company has been a principal shareholder of 
MindSpring Enterprises.  ITC, led by Cam Lanier, chairman, and Bill Scott, 
president, have established a successful record of financing and building 
telecommunications companies, such as SouthernNet, Telecom USA, Async, 
InterCell, InterCall, Interstate FiberNet and Interserve.

The MindSpring Core Values and Beliefs
At MindSpring, we are convinced that the key to creating a remarkable 
organization, internally and externally, is through an intense focus on values that 
guide its employees’ actions.  Please review these dynamic values and if we do not 
seem to be living up to them, please let us know.
· We respect the individual, and believe that individuals who are treated with 

respect and given responsibility respond by giving their best.
· We require complete honesty and integrity in everything we do.
· We make commitments with care, and then live up to them.  In all things, we 

do what we say we are going to do.
· Work is an important part of life, and it should be fun.  Being a good business 

person does not mean being stuffy and boring.
· We are frugal.  We guard and conserve the company's resources with at least 

the same vigilance that we would use to guard and conserve our own 
personal resources.

· We insist on giving our best effort in everything we undertake.  Furthermore, 
we see a huge difference between "good mistakes" (best effort, bad result) 
and "bad mistakes" (sloppiness or lack of effort).

· Clarity in understanding our mission, our goals, and what we expect from each 
other is critical to our success.

· We are believers in the Golden Rule.  In all our dealings, we will strive to be 
friendly and courteous, as well as fair and compassionate.

· We feel a sense of urgency on any matters related to our customers.  We own 
up to problems and we are always responsive.  We are customer driven.



MindSpring's Internet Services
MindSpring offers Dial-Up and Web Hosting accounts.  Dial-Up accounts provide 
a direct TCP/IP connection using the PPP protocol.  MindSpring carries a full 
Usenet feed with access to over 20,000 newsgroups.  
An updated list of the types of accounts we offer and pricing is maintained on our 
web page at http://www.mindspring.com/.

Dial-Up Accounts
Dial-Up accounts provide modem access at speeds up to 33.6 kbps.  In certain 
areas, dialup ISDN is available at speeds up to 128 kbps.  Bandwidth usage (see 
Glossary) varies depending on your service plan.  Most service plans include space 
on our server to put up your own web page or FTP files.  You have access to a 
summary report showing monthly total web page "hits" and bandwidth used on our 
web site at http://help.mindspring.com/.  The service includes use of "mailto" 
form and image maps on your web pages.  Your web page Uniform Resource 
Locator (URL), or address, will be http://www.mindspring.com/~username/.  
If you need a URL with your own domain name, multiple IP addresses (a subnet), 
more detailed reports, custom CGI scripts, secure server transactions or more 
bandwidth, please call our Sales Department about web hosting services.  For 
pricing information, please check our web page at http://www.mindspring.com/.

Dial-Up Plan Options

Extra Mailbox, Alias, or Vanity E-mail on the Same Account.
Mailboxes are used for e-mail only, and cannot be used to dial in to MindSpring by
themselves.  

Auto-response Mailbox.

Domain Name Registration and Mail Forwarding.
Domain name registration does not include the use of your domain name in your 
web page address.  Domain name web page addresses are available only for 
Hosting Service customers.  Current customers can register for a domain name 
online at http://www.mindspring.com/. 



800 Number Service.
MindSpring’s 800 Number Service is for use with Dial-Up Plans only - not for 
Dial-Up ISDN.  This service is billed in one second increments, with a 30 second 
minimum and includes 20 seconds for connect time.  This applies to ALL the time 
spent connecting via the 800 number, regardless of your billing plan.  The 800 
number is accessible from the United States (including Hawaii), but not from 
foreign countries.  

Web Hosting Services
Today, the Internet has an estimated 35 million users and is growing.  The World 
Wide Web is clearly one of the most popular Internet resources.  With new browser
technology being developed almost daily the future looks limitless.  Many 
MindSpring customers have discovered that by using the bandwidth available with 
their particular Internet access account to develop personal Web pages, they can 
reach out to a larger audience than they ever imagined.  However, many have felt 
limited by the disk space as well as establishing a name for themselves on the Web.
Many businesses and organizations want and need a “virtual” domain 
“http://www.yourdomain.com/”, detailed statistics, secure transactions, more disk
space and bandwidth as well as the ability to use custom CGI scripts.  In addition, 
these same businesses and organizations cannot justify the high cost of running 
their own Web server.
MindSpring Web Services provide a reliable, cost effective solution for individuals 
and organizations wishing to have a “virtual” Web presence 
(http://www.yourdomain.com/).
MindSpring can provide reliable server disk space and ample bandwidth to put you 
on the World Wide Web.  MindSpring has a dedicated World Wide Web staff to 
ensure a high level of performance and service needed to serve your Web pages to 
the World.
MindSpring’s network stability is the base to providing a reliable Web presence.  
To provide the best possible platform for Web Hosting, MindSpring has a 
dedicated engineering staff that maintains the robust network.  Furthermore, to 
ensure MindSpring stays abreast of any potential problem, MindSpring has a 
network monitoring team.  This team’s focus is to monitor the Local Area Network
(LAN), Wide Area Network (WAN), and our backbone to the Internet.  



Local Area Network (LAN) Stability
MindSpring’s network is housed in a state-of-the-art telephony, climate controlled 
environment, with full 24-hour Uninterrupted Power Supply (UPS).  The Network’s
backbone to the Internet is a T-3 (which provides bandwidth up to 45 Mbps) with 
backup redundant T-1s (each provides bandwidth up to 1.5 Mbps).  All Web 
Hosting customers are housed on multiple dedicated Web Servers.
MindSpring’s network features:
· Multiple dedicated Web servers - Sun Sparc servers running Solaris
· Excellent server performance - server up-time 99+%
· Local Area Network (LAN) stability and security
· MindSpring handles all System Administration of the LAN
· Engineering expertise - Dedicated to building and maintaining MindSpring’s 

LAN
· Remote network monitoring
· Daily file backup 
· Multiple dedicated Domain Name Servers (DNS)

Services Included in MindSpring Web Hosting
MindSpring provides many services to Web Hosting customers at no additional 
charge.  These services allow the customer to have a robust Web presence.  Web 
pages are becoming more dynamic with multimedia add-ons.  The following 
services are provided to our customers as part of their Web Hosting account:
· “Virtual” Domain name - The URL appears as 

http://www.yourdomain.com/.
· Domain name registration with InterNIC
· Detailed Web statistics - Number of “hits” on page, broken down by 

directories
· RealAudio - Progressive Networks' RealAudio client-server software system 

enables Internet and online users equipped with conventional multimedia 
personal computers and voice-grade telephone lines to browse, select, and 
play back audio or audio-based multimedia content on demand, in real 
time. This is a breakthrough compared to typical audio download times 
encountered over conventional online methods,  whereby audio is 
downloaded at a rate that is five times longer than the actual program and 
the listener must wait 25 minutes before listening to just five minutes of 
audio. 

· Secure transactions using Netscapes Commerce secure server  - Data is 
encrypted from end user’s browser to Server.

· Plug-and-play CGI scripts - Image maps, E-mail forms, guestbook, and 
counters

· The ability for Web designers to write custom CGI scripts - Supported 
languages; Perl 4, Perl 5, C and C++.  Please contact the MindSpring 
webmasters for C++ use.

· Online Web Help Desk - Dedicated Web Page support for MindSpring 
specific features http://webhelp.mindspring.com/

· High level of customer service and maintenance
· Customer has 24-hour access to web pages via FTP for 

maintenance/changes.
You are responsible for creating and updating all information on your web pages or
in the FTP directory.  Access to the files is via FTP (not Telnet).  Web space may 
be resold to other individuals.  However, if the individuals want an address such as 
http://www.theirdomain.com, they must purchase a separate hosting service 
directly from MindSpring. 
For pricing and additional information about MindSpring's Web Hosting Services, 
please check our web page, http://web.mindspring.com/.



MindSpring's Support Commitment
MindSpring is committed to making the Internet an enjoyable experience. We 
believe that the quality of the support we provide differentiates MindSpring from 
other Internet service providers.
This manual provides information on every aspect of the PipeLine+ software.  It is 
your main source of technical information and "How To" answers.
For questions regarding pricing, upgrades, billing, passwords, mailboxes, or other 
changes to your account, please contact Customer Service at (800) 719-4660 from 
9:00 a.m. to 9:00 p.m. (EST), Monday through Friday (except holidays), or via 
e-mail to service@mindspring.com.
If you are having difficulty with the PipeLine+ software, please:
· Consult this manual.  It was written to answer many common questions.
· Check the MindSpring Technical Support web page at 

http://help.mindspring.com/.
· Send an e-mail to Technical support at support@mindspring.com.
· Check the MindSpring newsgroups for help.  (See page 12 for a list of 

newsgroups).
· Contact Technical Support.  (See page 10 for guidelines.)
Technical Support is available 24 hours a day, 7 days a week, except for major 
holidays and announced down times.

MindSpring's Support Policy
At MindSpring we want our customers to have a great experience with MindSpring
and the Internet.  This means more than just providing a functioning network 
connection.  Customer Service and Technical Support are key ingredients and we 
strive to make our support responsive and high in quality.

The Nature of the Net
A gentle warning, many different systems are involved in connecting to the 
Internet, and none of them work perfectly all the time.  
· Software or hardware in your PC can cause problems.  The opportunities for 

conflicts are countless.  Data communications applications are particularly
likely to be troublesome on today’s PCs.

· Modems are also the source of many connection problems.
· The telephone network is a frequent generator of problems - such as noisy 

phone lines.
· The MindSpring network itself has many modems, servers and communication 

lines.  Despite our best efforts, at any given moment there may be a 
problem somewhere in our network.

· Finally, things out on the rest of the Internet, beyond MindSpring's control, 
may have problems.  The particular web server you want to connect to 
may be overloaded at any given moment.  The network connection leading
to some site may be out of order.  Sometimes the “routing” for large 
sections of the Internet even gets knocked out of service temporarily.

Guidelines for Using MindSpring Technical Support
All this makes our support task here at MindSpring quite complex!  Please help us 
by living within these guidelines while using our support resources, and we’ll try 
our best to provide you with the best support you have ever experienced.  This is 
how you can help us to best help you:
· Please respect the boundaries of our support operation.

· We provide phone and e-mail support for the software products included in the
PipeLine+ Starter Kit.  We can supply technical support for the 



installation, configuration, and possible troubleshooting of the PipeLine+ 
software.  Training and tips for use of the software, once installed and 
working, are available:

- In this manual
- Through the Support web page at http://help.mindspring.com/
- From the help files supplied with most of the software products included 

in the PipeLine+ Starter Kit
- From approved MindSpring Training facilities

· Also, many questions are posted and answered by fellow MindSpring users in 
the MindSpring newsgroups.

· Please don't ask us to provide support for other software products.  Internet 
software applications are multiplying at an incredible rate, and we simply 
cannot be experts on all of them.  We do maintain HELP resources for 
those using software and operating systems that MindSpring does not 
support over the telephone, and we urge you to make use of these.

· MindSpring Technical Support cannot provide training in the use of your 
computer or the Internet in general.  To use MindSpring and the Internet, 
you need to master the basic skills necessary to use your computer, such as
opening and closing programs and files, and using dialog boxes.  Please 
try one of the training classes available through MindSpring in selected 
cities.

· Please try the following help resources before calling us on the phone:
- Consult this User's Guide and the online Help that comes with your starter 

kit.
- Check our Help web pages maintained at http://help.mindspring.com/.
- Check the MindSpring newsgroups devoted to providing help on various 

topics.
- Send an e-mail to support@mindspring.com stating the nature of the 

problem.
- Finally, as a last resort, telephone our support representatives at (800) 719-

4660 or (404) 815-9111.
· Last but not least, we request your best manners.  Almost always you will call 

at a time when you are frustrated and perhaps angry.  Please understand 
that we are here to help and we ask that you do not take your frustration 
out on the Technical Support Representatives.  The MindSpring Core 
Values and Beliefs call for treating people with respect.  We will try very 
hard to live up to those standards when dealing with you and ask that you 
do the same when speaking with us.

Contacting MindSpring Support
When you call technical support, call from a telephone located near your computer 
and have the following information handy:
· Your MindSpring mailbox name and password
· PipeLine+ software product name and version number
· The brand and model of your computer (for example, Gateway 2000 Pentium 

133 MHz)
· The brand, model and speed of your modem (for example, US Robotics - 

PCMCIA Sportster - 28.8).  If you have encountered an error message, 
please document.

· Operating system and version number.  To find the version number for your 
operating system, do one of the following:

- Windows 3.1 and 3.11 users, choose Help | About from Program Manager.
- Windows 95 users, right-click on My Computer and select Properties.
- Macintosh users, while in Finder, click on the apple and select About This

Macintosh (if using System 7.6, then select About This Computer).



· The amount of memory (RAM) in your system.  To find the amount of 
memory in your system, do one of the following:

- Windows 3.1 and 3.11 users, choose Help | About from Program Manager.
- Windows 95 users, right-click on My Computer and select Properties.
- Macintosh users, while in Finder, click on the apple and select About This

Macintosh (if using System 7.6, then select About This Computer).
· The amount of available uncompressed hard disk space in your system.  To 

find the amount of available uncompressed hard disk space in your system,
do one of the following:

- Windows 3.1 and 3.11 users, type DIR in DOS.

- Windows 95 users, right-click on My Computer and select Properties.
- Macintosh users, double-click on the Hard Drive icon (the Views control 

panel must have Show disk info in header selected).

MindSpring's Newsgroups
The newsgroups are accessible by users 24 hours a day and it can be the ideal 
forum for addressing questions that are related to the software.  If you think that 
others may be experiencing the same problem or that an individual may have had a 
similar situation, please post the question to the appropriate newsgroup.  Be sure to 
provide the appropriate amount of background information; this allows MindSpring
as well as others to properly address your question.  

Notes:  These newsgroups are restricted access and available only for MindSpring 
users.  Remember, always read the postings before posting your question, as it may 
have already been answered.

The following is a list of some of the available topical MindSpring newsgroups:

Newsgroup Topics Covered

mindspring.discussion By, for, and about MindSpring users

mindspring.help Technical questions

mindspring.www World Wide Web and HTML

mindspring.users.win95 Issues relating specifically to 
Win95 and 32-bit

mindspring.local.cityname Local newsgroups are established 
for many of our POP locations

mindspring.users.linux Linux - a UNIX operating system 

mindspring.users.os2 IBM OS/2 

mindspring.users.mac Macintosh

mindspring.users.isdn Connecting with ISDN

E-mail
If you can connect to MindSpring successfully, please send a message describing 
your problem to support@mindspring.com.  Within your e-mail, please include 
your MindSpring username and describe the problem in significant detail.  
MindSpring monitors e-mail during normal support hours.  We will answer the 
question or redirect the user to the appropriate resources.  Please remember to 
include your MindSpring mailbox name.



MindSpring's Appropriate Use Policy
The following provides a general understanding of MindSpring's policy on the 
Appropriate Use of MindSpring services.  Common sense and judgment are a 
necessary part of any system of rules, and this AUP is no exception.  Of course, 
flagrant or repeated violations of the Policy are viewed in a very different light than
minor infractions.  
Protection of our customers and our resources, the ability to provide quality service
to our customers, conformance with existing law, and the protection of our 
reputation as a service provider are all contributing factors to decisions on AUP 
violations.
It is our intention to allow MindSpring customers access to everything the Internet 
has to offer with minimal or no interference.  Our belief in Free Speech is a firm 
commitment to our customers.  However, Free Speech does not include the right to 
shout "Fire" in a crowded theater.  In an analogous manner, certain activities are 
considered inappropriate by the Internet community at large, and cannot be 
permitted under the guise of Free Speech.
MindSpring does not censor the content of any newsgroups.  We believe such 
choices should be left to the individual.  We do advise our users that tools, such as 
Cyber Patrol, are available to screen an account's access to newsgroups one 
considers offensive.  It is the account owner's responsibility to make use of such 
tools if desired.
MindSpring does not monitor the activity of accounts except for measurements of 
system utilization and billing records.  However, in our efforts to promote good 
citizenship within the Internet community, if we become aware of inappropriate 
use of MindSpring service, we will respond.
If MindSpring account is used to violate the AUP, we reserve the right to terminate 
service without notice.  Our preferred course of action would be to advise the 
account owner of the inappropriate behavior and corrective action necessary.  
However, flagrant violations of the AUP will result in immediate termination of 
service. 
In the event that an account is temporarily inactivated as a result of any prohibited 
activities, the account may be subject to reactivation charges and/or deposit 
requirements to be determined by MindSpring.

Note:  Please refer to our web page, http://www.mindspring.com/, to make sure 
you are fully aware of our Appropriate Use Policy.



Statement of Policy
Our Appropriate Use Policy (AUP) is designed to help protect our customers, and 
the Internet community, from irresponsible or illegal activities.  As good net 
citizens, we prohibit the impersonation of others, unsolicited commercial appeals, 
and any disruption of Internet services.  Examples of such activities are given 
below:

E-mail
Inappropriate 
Activities Description

Commercial
 e-mail

Sending unsolicited commercial e-mails is prohibited. 
Using a MindSpring or PipeLine e-mail address to 
collect responses from unsolicited commercial e-mail 
is prohibited. 

Mail Bombing Sending large volumes of unsolicited e-mail to 
individuals.

Harassment Sending threatening or harassing e-mail after being 
requested to stop, is prohibited.  Extremely threatening
or harassing e-mail is prohibited always.

News
Inappropriate 
Activities Description

Newsgroup 
Spamming

Excessive cross-posting, or posting the same article to 
several newsgroups, is prohibited.  Generally accepted 
standards allow no more than 15 newsgroups, or cross-
postings, for a single article or substantially similar 
articles.  Such articles may be canceled.

Off-topic or 
inappropriate 
postings

There is no restriction on content, except as defined by
each newsgroup.  Continued posting of off-topic 
articles is prohibited. Please note that commercial 
advertisements are off-topic in the vast majority of 
newsgroups.

Internet Relay Chat (IRC)
The use of IRC bots is prohibited, as is the violation of any accepted policies on 
IRC servers.  If MindSpring is banned from a server, the offending account will be 
terminated.

General
Inappropriate 
Activities Description

Impersonation Attempting to impersonate any person, using forged 
headers or other identifying information, is prohibited.
The use of anonymous remailers and nicknames does 
not constitute impersonation.

Network 
unfriendly activity

Activities which adversely affect the ability of other 
people or systems to use MindSpring services or the 
Internet is prohibited.

Privacy violations Attempts, whether successful or not, to gain access to 
any computer system, or customer's data, without 
consent is prohibited.



Financial 
Sharing Unlimited or Works accounts with anyone other than immediate family 
member, or re-selling service without express written consent from MindSpring, or 
offering any public information service, such as running a web server or FTP 
server, is prohibited.  Using programs to defeat system timers limiting inactivity is 
prohibited.  Untimely payment of any and all amounts due may result in account 
cancellation. 

Bandwidth and Disk Utilization
MindSpring account descriptions specify limits on bandwidth and disk utilization 
and use in excess of those limits is not permitted.
· Bandwidth utilization is determined by the total number of bytes transferred 

from an account’s Web and FTP space.    
· Disk utilization is determined by the total number of bytes required to store an 

account’s Web, FTP, and Mail data.
In the event MindSpring determines that an account is exceeding the bandwidth or 
disk utilization, the account owner will be notified by e-mail.  If the excess use 
continues for more than 48 hours after such notification, the owner may be 
requested to upgrade the account’s service agreement or to modify the activity 
creating the excess use.
If excessive bandwidth or disk space utilization is determined to adversely affect 
MindSpring’s ability to provide service, immediate action will be taken.  The 
account owner will be notified by e-mail as soon as practicable.



Privacy
It may be necessary for MindSpring employees to examine system accounting logs 
and other records to resolve system problems.  MindSpring reserves the right to 
access an account’s mailbox to resolve system problems or mail system errors.
In addition, MindSpring will cooperate with the appropriate legal authorities in 
investigating claims of illegal activity, including but not limited to illegal transfer 
or use of copyrighted material, postings or e-mail containing threats of violence, or 
other illegal activity.
MindSpring makes no guarantee and assumes no liability for the security of any 
data on any server including “secure servers.”
Our customers are reminded that no computer system should be considered safe 
from intrusion.  E-mail may pass through many computer systems, and should not 
be considered a secure means of communication unless encrypted.  Even then, 
information is only as secure as the encryption method.

Account Security
When MindSpring creates your individual account, we provide you a randomly 
generated password unless you request otherwise.  It is highly recommended that 
you create passwords that are not a name, date (birth dates, phone numbers, etc.), 
word or number associated with you or your family.   They are much easier to 
guess if anyone ever tried to break into your account.  In addition, please do not 
give your password to anyone or write it down anywhere.
When an account is opened each individual provides a "secret word" that 
MindSpring will use to verify your identity during any sales or billing phone calls.  
MindSpring will not give out or change any account information for any caller who
does not have that secret word.



Netiquette
To better define netiquette, it would probably be best if we start by briefly defining 
the Internet.  The Internet is a community of people, linked together by a 
worldwide network of computers, and often these networks are made up of smaller 
networks.  Netiquette is the term used to describe a code of social behavior, and is 
derived from (yes, you guessed it) the word etiquette.
Everyone on the Internet holds a personal responsibility for how it will evolve as it 
becomes commonplace in all our lives.  While on line, we each have the option to 
be considerate and thoughtful about how we communicate with the world.  We do 
not have the added luxury of facial expression or body language to make our point, 
so it will be the words we type and upload for the world to view that are going to 
create the impression on the person viewing them.  The mood of the message will 
be based primarily on literal (or sometimes graphical) impression. 
Place your comments and postings in the appropriate places.  For example, do not 
post a network marketing announcement in the newsgroup "comp.dcom.modems."  
Although there is much room for commercial use of the net, many areas are not 
suitable for this. 

Netiquette Guidelines
The discussion of netiquette is most relevant to the services that individuals use to 
communicate with other people whether through e-mail, newsgroups or Web page. 
The following are two key definitions to understanding the basics of netiquette on 
the Internet:
· Flame — Violent verbal expressions of disapproval, can result in a "flame 

war".  Don't underestimate the power of an apology should you make a 
mistake while you are learning.

· Spam — Cross posting of inappropriate messages to multiple newsgroups.  
This can result in the cancellation of your account in addition to flaming 
recriminations from your fellow netizens (net citizens).

E-mail Specific Guidelines
Electronic mail is a communication medium that represents a cross between 
making a phone call and writing a letter.  You can e-mail a message to anyone with
an e-mail address anywhere in the world providing unparalleled communication 
access and response.  The following are general netiquette guidelines for e-mail, 
newsgroups and IRC:



· Mass unsolicited e-mailing is extremely inappropriate and may result in the 
cancellation of your account.

· ALL CAPITAL LETTERS is considered the equivalent of yelling and is bad 
form.  Users are encouraged to utilize *asterisks* or _underlines_  to 
emphasize specific segments of text.

· Re-read your message carefully prior to sending it.  Similar to using the phone 
or "snail mail" (the postal service), in e-mail you lack the ability to use 
gestures or facial expressions to support your message.  In addition, 
monitor how you use sarcasm or humor because your message may not be 
received in the spirit that it was sent.

· Check your spelling.  A misspelled word can change the mood of the message. 
For example, "Does anyone know how to send an e-mail massage?".

· Observe grammar and rules of punctuation to the best of your ability.  Use of 
non-standard writing will hamper the ability and desire of others to receive
the information you are sharing.

· Keep paragraphs short and succinct.
· Focus on one subject per message.
· Cite all quotes and references.
· Do not send lines with more than 70 characters.  Observation of this rule will 

assist terminal-based news readers and mail editors.  In addition, some 
mail gateways truncate extra characters, turning your prose into gibberish. 

· Do not include the entire contents of a previous posting or mail message in 
your reply.  MindSpring's news server, like many others, is set to refuse 
posts that include more quoted text than new text.

· Be conscious of the fact that the Internet is an international medium.  This 
means that North American expressions, values, and laws are not 
dominant.  For example, a user from Sweden may not have a great deal of 
interest in learning about your First Amendment rights, as they may have 
never heard of the First Amendment. 

· Do not re-distribute e-mail that you have received privately from anyone by 
forwarding it to anyone else, posting it on a newsgroup or web page unless
you have specific permission from the author to do so.

· Include your signature at the bottom of e-mail and Usenet messages.  This 
signature should include your name and e-mail address and should not 
exceed four lines.



· The following are symbols and anachronisms that are frequently used in e-
mail, newsgroup postings or chat text.  Make sure to turn your head 
sideways to best view the first five:

·
Symbols Meaning
:-)  or   :) Smile
:-(  or   ;( Frown
>:[ Anger
:-o Surprise
;-) Wink
<g> Grin
IMHO In my humble/honest opinion
FYI For your information
BTW By the way

Newsreader Specific Guidelines
Newsfeed, such as Usenet, is a group of servers that exchange "articles" that are 
categorized by topic and tagged by commonly known labels that designate the 
source or forum from where the articles originated.  All of the netiquette 
suggestions and guidelines listed above for e-mail are pertinent to posting messages
in the newsgroups.  The following are specific guidelines for newsgroups:
· Post messages only within the appropriate newsgroups.  Posting of a message 

to multiple or inappropriate newsgroups is called spamming, see
Statement of Policy, on page 14.  The penalties arising from spamming 
can result in the cancellation of your account. 

· Posting personal messages.  If you mail to a person and the mail does not make
it through, do not post the message to the person.  The person will most 
likely post another message, at which time you can copy their address for 
your use. 

· It is considered poor netiquette to post any e-mail that someone may have 
individually sent you, unless you get their permission first.  This is the 
equivalent of posting a personal letter at the town square public notice 
board. 

· If you should decide to test your message posting ability, use one of the many 
test groups that are found on Usenet (e.g., mindspring.test).  You are 
encouraged to test before you start posting messages, just do it in its 
proper place. 

· Before you post to a newsgroup, wait and be an observer (lurk) for a couple of 
weeks.  Most groups post a FAQ (frequently asked questions) that tells you
what the group is about.  Read news.newusers or 
news.newusers.questions for more tips.



FTP (File Transfer Protocol) Guidelines
· Check for copyright and licensing agreements on all the files that you 

download.  If the software is useful to you,  pay any author's or developer's
registration fee.  If there is any doubt about whether it is shareware or 
freeware, don't copy it. 

· In addition, do not use the disk space that you have available through your 
service plan on the MindSpring server for files that cannot be freely 
distributed due to copyright or licensing restrictions.

Web Page Guidelines
· Do not put anything on your web pages that does not belong to you.  That 

means no copyrighted graphics, lyrics to your favorite songs, sound files 
of others’ recordings, and so forth.

· Do not put pictures of anyone on your web pages without their express 
permission.

· It is polite to request permission before linking to anyone else's site from your 
web page.

· If your pages contain any adult material, post a notice near the beginning to 
warn off those who might be offended.

The Ten Commandments of Computer Ethics
Compiled and published by the Computer Ethics Institute, the following Ten 
Commandments provide the most succinct guidelines for activities on the Internet.
· Thou shalt not use a computer to harm other people.
· Thou shalt not interfere with other people's computer work.
· Thou shalt not snoop around in other people's files.
· Thou shalt not use a computer to steal.
· Thou shalt not use a computer to bear false witness.
· Thou shalt not use or copy software for which you have not paid.
· Thou shalt not use other people's computer resources without authorization.
· Thou shalt not appropriate other people's intellectual output.
· Thou shalt think about the social consequences of the program you write.
· Thou shalt use a computer in ways that show consideration and respect.

Additional Netiquette Information
MindSpring would like to thank Anne Rinaldi for putting so much Netiquette 
information in one place.  Visit her Netiquette page on the World Wide Web at 
http://rs6000.adm.fau.edu/rinaldi/netiquette.html.
For updates on netiquette via the newsgroups, please refer frequently to:
· news.newusers.questions
· news.announce.newusers 

Chapter 2



Installing the Software

This chapter provides general information about installing the software.  The following topics are 
covered:

· What the software installation program does

· How to install the software

· A brief description of the Internet client software that come with PipeLine+

Chapter Table of Contents
This chapter includes the following sections:
Section Page
Before You Install 22
About the PipeLine+ Installation 23
Running Setup for PipeLine+ – Windows 3.1 and 3.11 24
Running Setup for PipeLine+ – Windows 95 25
Running the Installer for PipeLine+ – Macintosh 29
Internet Applications Installed 31
Configuring Multiple Mailboxes 33



Before You Install
This section provides some simple steps to help you prepare to install the 
PipeLine+ software.

Read the Service Agreement
Read the MindSpring Enterprises, Inc. Service Agreement provided on page 165.  
This agreement states that you will use the software in accordance with the terms 
specified.

Review the Read Me File
The README.TXT file contains last minute information that may not be in this 
manual.  It can be viewed in Notepad (Windows) or TeachText/SimpleText 
(Macintosh).  We recommend you view the README.TXT file prior to installing 
PipeLine+ software.

Minimum System and Software Requirements
The PipeLine+ software requires the following minimum system configuration to 
run properly:
· Windows 3.1, 3.11, or Win95 on a 486 processor with 8 MB of RAM
· Macintosh:  System 7.1 or higher on a 68020 processor 
· 8 MB of RAM or memory
· A 14.4 or faster modem capable of hardware handshaking
· PC users need a serial port with a 16550 UART
· Macintosh users need a hardware handshaking cable

Helpful Information
Some 14.4 modems are based on the RPI (Rockwell Proprietary Interface) chipset.  
They rely on software to provide error correction and data compression. Our 
software, like most communications programs, does not provide the support these 
modems need to establish a reliable connection.
If you use a 28.8 modem, please be sure it supports the v.34 standard.  Our servers 
do not support the v.fc (VFast Class) protocol used by some 28.8 modems.



Other Important Information
· Our software was designed for standalone, not networked PCs.
· The proprietary versions of Windows (called OEM versions) distributed with 

some PCs can cause occasional problems, as these versions often use 
nonstandard drivers.

· The use of proprietary interfaces (e.g., Norton Desktop, Compaq TabWorks, 
Packard Bell Navigator, At Ease) may cause software conflicts.  Since 
these are not standard software interfaces, they may impair the ability of 
our technicians to provide support.

· Please do not attempt to run the PipeLine+ software while any other 
communications software (e.g., fax software) is running on your computer.

· The Windows software will not run properly under Windows NT or OS/2.
· Before installing any new software on any computer, you should be sure you 

have a complete, current backup, and current boot disks at hand.  Routine 
system maintenance such as virus detection, disk scanning, and drive de-
fragmentation is also recommended.

About the PipeLine+ Installation
The PipeLine+ software comes with an automated installation program.  The 
installation program will:
· Automatically create directories (Windows) or folders (Macintosh) and copy 

the files from the distribution disks to your hard drive.
· Install and configure the Internet applications included in your PipeLine+ 

package.
· Install the online Help and documentation built into the Internet applications, 

where available.

The following installation procedures:

· Address the three computer platforms supported by MindSpring Enterprises – 
Windows (versions 3.1 and 3.11) , Windows 95 and Macintosh.

· Are annotated for both CD-ROM and diskette installations.

If you are installing the PipeLine+ software for... Turn to...
Windows 3.1 or 3.11 Page 24.
Windows 95 Page 25.
Macintosh Page 29.



Running Setup for PipeLine+ – Windows 3.1 and 3.11
Step Action

1 If you are installing from:
· CD-ROM, place the PipeLine+ CD in your CD-ROM drive.
· Diskette, place Disk 1 in your floppy drive.

2 From Program Manager, select Run from the File menu.

3 If you are installing from:

· CD-ROM, type d:\setup (or x:\setup where x is your CD-
ROM drive letter), and click OK.

· Diskette, type a:\setup (or b:\setup if your floppy disk drive
is known as your b: drive) and click OK.

The PipeLine+ installation program starts. If you are installing 
from CD-ROM, you will need to enter the CD Registration 
Key information included with your PipeLine+ software 
package.

4 Follow the instructions on the Setup screens.
Note:  If you are installing from diskettes, change the 
diskettes when prompted by the installation program.

5 When the PipeLine+ Setup dialog box appears, type your account 
information into the following fields, using the specific setup 
information included with your PipeLine+ software package:

· Full Name - Type your name.
· User ID (case sensitive) - Type your User ID.
· Password (case sensitive) - Type your login password.
· Mailbox (case sensitive) - Type your mailbox name (this will 

correspond to the portion of your e-mail address to the left of 
@)

· Mail Pass (case sensitive) - Type your mailbox password.
And then select values from a drop-down list for:

· Domain - Choose the domain specified on your setup information 
sheet (this will correspond to the portion of your e-mail 
address to the right of @)

· State - Choose the state from which you will be dialing in.
· City - Choose the city from which you will be dialing in.
· Connection Type - V.34 (modem), ISDN (64k), 2B ISDN (128k)

Step Action

· Modem - Select your modem
· Port - Select your modem port (usually COM2)
· Speed - 14.4 modems enter 19,200; 28.8 modems enter 38,400

6 Click the OK button to proceed.  

That's it!  When the installation is complete, the program prompts you
to restart Windows.

7 Be sure to close all other applications before you restart Windows.

Where do I 
go from here?

Read Internet Applications Installed on page 31.



Running Setup for PipeLine+ – Windows 95

Note:  If you are installing this software onto a Network or LAN, please consult 
your network administrator first.  Microsoft DUN and TCP/IP protocols will be 
installed which may interfere with existing network protocols.

Follow these steps to run the installation program:

Step Action

1 If you are installing from:
· CD-ROM, place the PipeLine+ CD in your CD-ROM drive.
· Diskette, place Disk 1 in your floppy drive.

2 From the Windows 95 Start button, select Run.

3 If you are installing from:
· CD-ROM, type d:\setup (or x:\setup where x is your CD-

ROM drive letter), and click OK.
· Diskette, type a:\setup (or b:\setup if your floppy disk 

drive is known as your b: drive) and click OK.
The PipeLine+ installation program starts. If you are installing 
from CD-ROM, you will need to enter the CD Registration 
Key information included with your PipeLine+ software 
package.

4 You will be given the options of selecting a New or Custom 
installation of the PipeLine+ software.  A New installation will install
the following components:

Eudora Mail Files
Internet Explorer Software Files
Free Agent Files
Internet Relay Chat Files
WSFTP Files
Ewan Telnet Files
WinZip Utility Files
LView Utility Files
WinCode Utility Files

Custom install will allow you to choose from the above.

5 You will be given the opportunity to select a custom installation 
directory and program folder.  You will also be informed which files 
will be copied during installation.  

6 If installing from diskette you will be prompted to insert the 
remaining diskettes.
Several screens will automatically open and close.  If you do not 
already have Microsoft DUN and TCP/IP installed to your system you
will be prompted for your Windows 95 installation media.

7 A Network dialog box may appear reporting that:
“You must specify a workgroup for your computer in the 
workgroup box.”
If you do not see this message you may advance to step 13!
Clicking OK will bring you to the Network Setup:



Step Action

The Network Identification screen will request:
   Computer Name:
   Workgroup:
   Computer Description:
These fields will not be used by PipeLine+.  For simplicity enter your 
first name for Computer Name and your last name for Workgroup 
and leave Computer Description blank.  Click Close.  Files will be 
copied over from your Windows 95 installation media.

8 Dial-Up Networking Setup will inform you:
“Your system settings are reconfigured: Restart your computer
when Add/Remove Programs is complete to use Dial-Up 
Networking or Direct Cable Connection”
Click OK .

9 Restart your computer by clicking on Start, then Shut Down and 
select Restart the Computer and click Yes.

10 Do not be alarmed.  You will see the following:

IMPORTANT: This is not your MindSpring user ID and 
password.  This is your Windows95 username and password.  
For simplicity, enter your username in the username field, but do
not enter any text in the password field.  
If you specify a password, you will be greeted with the above 
screen every time you start Windows 95 and will need to provide
that username and password.  If you leave the password blank, 
this should be the last time you see the above screen.



Step Action

11

If you entered no password, please click OK .  Otherwise enter
your new Windows password twice.   This is to ensure against 
typographical  errors. 



Step Action

12 Setup should open and close several screens, and then you will see:

Click on Yes.

13 When the PipeLine+ Setup dialog box appears, type your account 
information into the following fields, using the specific setup 
information included with your PipeLine+ software package:

· Full Name - Type your name.
· User ID (case sensitive) - Type your User ID.
· Password (case sensitive) - Type your login password.
· Mailbox (case sensitive) - Type your mailbox name (this will 

correspond to the portion of your e-mail address to the left of 
@)

· Mail Pass (case sensitive) - Type your mailbox password.
And then select values from a drop-down list for:

· Domain - Choose the domain specified on your setup information 
sheet (this will correspond to the portion of your e-mail 
address to the right of @)

· State
· City
· Connection Type - V.34 (modem), ISDN (64k), 2B ISDN (128k)
· Dial Prefix - 9 or 8 (to reach an outside line), *70 (to disable call 

waiting while you are connected to MindSpring)

· Click OK after you have entered all the information.

14 You will see a screen reading:

“To start using your new account, please double click on the 
MindSpring PipeLine+ icon on your desktop and then hit connect.”  

Click OK.

Where do I 
go from here?

Read Internet Applications Installed on page 31.



Running the Installer for PipeLine+ – Macintosh
The following procedures describe installation and initial configuration of 
PipeLine+ software for Macintosh.  Follow these steps to run the Installer:

Step Action

1 · CD-ROM, place the PipeLine+ CD in your CD-ROM 
drive.

· Diskette,  place Disk 1 in your floppy drive.

· 2 Double-click on the Installer icon.  
Several information boxes appear.   Click on each to continue. 
The PipeLine+ Installer window displays and the program 
begins.

3 Select the type of installation:
· Easy Install (the whole package; recommended for the first-time 

install)

· Custom Install (selected applications only)

The Installer creates a  PipeLine+ folder in the default location
(the default location is the top level of your hard drive).   To 
select your desktop, or a different folder on your hard drive, 
click on Select Folder.  If you have more than one drive 
mounted (displayed on your desktop), click on Switch Disk or 
select the drive or folder you want using the pop-up menu.

4 Click on the Install button. If you are installing from CD-
ROM, you will need to enter the CD Registration Key 
information included with your PipeLine+ software package. 
A progress window displays while the installation is taking 
place.   

Change diskettes when prompted by the Installer.

5 A message appears when the installation is complete.   Click 
the Quit button to quit the Installer and continue with initial 
configuration.  



Step Action

6 When the PipeLine+ Easy Setup dialog box appears, type your
account information into the following fields, using the 
specific setup information included with your PipeLine+ 
software package:

· Full Name - Type your name.
· Organization - Type your company name (optional).
· User ID (case sensitive) - Type your User ID.
· Password (case sensitive) - Type your login password.
· E-mail Address - Type your full e-mail address.
· Mailbox (case sensitive) - Type your mailbox name (this will 

correspond to the portion of your e-mail address to the left of 
@).

· Password (case sensitive) - Type the mailbox password.
And then select values from a drop-down list for:

· Domain - Choose the domain specified on your setup information 
sheet (this will correspond to the portion of your e-mail 
address to the right of @)

· State
· City
· Connection Type - V.34 (modem), ISDN (64k), 2B ISDN (128k)
· Modem - Select your modem
· Port - Select your modem port (usually COM2)
· Speed - For 14.4 modems, enter 19,200, 

             For 28.8 modems, enter 38,400

7 A message appears when the initial configuration is complete 
prompting you to restart your computer for the new software 
to take effect.  Click the OK button.  Restart your computer.

Where do I 
go from here?

Read Internet Applications Installed on page 31.



Internet Applications Installed
The PipeLine+ software contains a suite of our favorite Windows 3.1 and 3.11, 
Windows 95 and Macintosh Internet applications.  
The following cross-platform application for Windows 3.1 and 3.11, Windows 95 
and Macintosh is installed:
· Eudora Light software, an E-mail program by Qualcomm Corporation.  Freeware.

The following additional Windows 95 application is installed:
· Internet Explorer software, a World Wide Web browser by Microsoft.  Commercial 

product, licensed for you through MindSpring.

The following additional Windows applications are installed:
· Free Agent, a Newsreader by Forte.  Freeware.
· WS_FTP, an FTP client by John A. Junod.  Freeware.

· mIRC, an IRC client by Khaled Mardam-Bey.  Shareware.

· EWAN/Telnet, a terminal emulator.
· LView Pro, a graphics viewer by Leonardo Haddad Loureiro.  Shareware.
· Wincode, an encoding / decoding utility by Snappy Software.  Freeware.
· WinZip, a decompression program by Niko Mac Computing.  Shareware.
· Nettools, an Internet applications toolbar.  Freeware (Windows 3.11 only).
· McAfee Virus software (on CD-ROM only). 

The following Macintosh specific applications are installed:
· Netscape Navigator software, a World Wide Web browser by Netscape 

Communications.  Commercial product, licensed for you through MindSpring 
· Anarchie, an FTP client by Peter N. Lewis.  Shareware, licensed to you through 

MindSpring.
· Homer, an FTP client by Toby Smith.  Shareware.
· Fetch, an FTP client by Dartmouth University.  Shareware.
· StuffIt Expander, an encoding / decoding utility by Aladdin Systems.  Freeware.
· JPEGView, a graphics viewer by Aaron Giles.  Postcardware.
· SoundMachine, a sound file player by Rod Kennedy.  Shareware.
· Newswatcher, a newsreader by Northwestern University.



A Notice about Licensed Products and Shareware
As is indicated above, most of this software is freeware, some of it is shareware, 
and some are commercial products which we have licensed for you.  
DO NOT distribute the Netscape Navigator application - this is NOT shareware or 
freeware.  
If you want to continue using the shareware products included with your PipeLine+
software, beyond the thirty-day trial period, you should pay the shareware fee to 
the program's author as described in the program's documentation.  

Notice:  MindSpring encourages you to pay the shareware fees for any programs 
which you decide to keep and use.  We've included these programs in this package 
because we think they are the best ones available for their respective jobs.  There 
are other Internet client programs available, and you may prefer to use one of these 
rather than registering these shareware programs.   



Configuring Multiple Mailboxes
Note:  This section is intended only for users who have multiple mailboxes as part 
of their MindSpring account.  

Setting Up Multiple Mailboxes for Windows 3.1 and 3.11
Follow these steps to configure extra mailboxes:

Step Action

1 From File Manager,  create a directory named EUDORA2 in 
C:\PIPEPLUS.  (EUDORA2 is used as an example.   The 
directory name can be anything other than EUDORA.)

2 Copy the C:\PIPEPLUS\EUDORA directory and its contents to
the C:\PIPEPLUS\EUDORA2 directory.

3 From the PipeLine+ Access Panel, click Configure to choose 
the button that you wish to use as the second Eudora mailbox. 
The PipeLine+ Configuration screen appears.

4 Select the Tool Panel tab.  The Tool Panel screen appears.

5 Select the button you want to use for the new mailbox; and 
then select the Find Target button.  The Icon Configuration 
window appears asking you to select a program to associate 
with the new button.

6 Find the second copy of Eudora that you created in Step 2 (C:\
PIPEPLUS\EUDORA2).  Select the directory and click OK.  
The Tool Panel screen appears again, and the button's icon 
now changes to the Eudora icon.

7 Click OK.  

8 Click the button you configured for the new Eudora mailbox 
from the PipeLine+ Access Panel.  (If the software tries to 
check your mail,  press Cancel.)

9 Next, select Tools | Options | Personal Information to configure 
this copy of Eudora for the new mailbox address.

Step Action

10 Change the POP Account and Return Address to reflect the 
new mailbox name (i.e. change the portion to the left of the 
"@" symbol).  You can also change the Real Name to 
whatever you want.

11 Once you have configured Eudora for the new mailbox, close 
Eudora.

12 Connect to MindSpring.  The daily announcements appear.

13 Click the new Eudora button, and then click File | Check Mail.  
The program prompts for the password for this mailbox.

14 Enter the password carefully (make sure your caps lock key is 



Step Action

off).  If you entered it correctly,  Eudora checks for new mail 
for the new mailbox.

Note:  To check mail for this box from this point, close any 
other copies of Eudora and click the configured icon.

Setting Up Multiple Mailboxes for Windows 95
Note:  This section is intended only for users who have multiple mailboxes as part 
of their MindSpring account.  

Follow these steps to configure extra mailboxes:

Step Action

1 From Windows Explorer, create a directory named EUDORA2 
in C:\PIPEPLUS.  (EUDORA2 is used as an example.   The 
directory name can be anything other than EUDORA.)

2 Copy the C:\PIPEPLUS\EUDORA directory and its contents to
the C:\PIPEPLUS\EUDORA2 directory.

3 From the PipeLine+ Access Panel, click Configure to choose 
the button that you wish to use as the second Eudora mailbox. 
The PipeLine+ Configuration screen appears.

4 Select the Tool Panel tab.  The Tool Panel screen appears.

5 Select the button you want to use for the new mailbox; and 
then select the Find Target button.  The Icon Configuration 
window appears asking you to select a program to associate 
with the new button.

Step Action

6 Find the second copy of Eudora that you created in Step 2 (C:\
PIPEPLUS\EUDORA2).  Select the directory and click OK.  
The Tool Panel screen appears again, and the button's icon 
now changes to the Eudora icon.

7 Click OK.  

8 Click the button you configured for the new Eudora mailbox 
from the PipeLine+ Access Panel.  (If the software tries to 
check your mail,  press Cancel.)

9 Next, select Tools | Options | Personal Information to configure 
this copy of Eudora for the new mailbox address.

10 Change the POP Account and Return Address to reflect the 
new mailbox name (i.e. change the portion to the left of the 
"@" symbol).  You can also change the Real Name to 
whatever you want.

11 Once you have configured Eudora for the new mailbox, close 
Eudora.

12 Connect to MindSpring.  The daily announcements appear.

13 Click the new Eudora button, and then click File | Check Mail.  
The program prompts for the password for this mailbox.

14 Enter the password carefully (make sure your caps lock key is 



off).  If you entered it correctly,  Eudora checks for new mail 
for the new mailbox.

Note: To check mail for this box from this point, close any 
other copies of Eudora and click the configured icon.

Setting Up Multiple Mailboxes for Macintosh
Note:  This section is intended only for users who have multiple mailboxes as part 
of their MindSpring account.  

Follow these steps to configure extra mailboxes:

Step Action

1 Quit Eudora if it is running.

Step Action

2 Find the Eudora folder on you hard disk.  It is usually in the 
System folder.

3 Make a copy of the Eudora Settings file.   You can rename the 
copied file to anything you like, such as Eudora2.

4 Move the Eudora Settings copy into a new folder.  It can be 
anywhere on your hard drive, and is not limited to the System 
Folder.

5 Double-click the new Eudora Settings file (e.g., Eudora2).  
Eudora automatically creates all the necessary files.

6 Next, select Special | Settings to configure this copy of Eudora
for the new mailbox address.

7 Change the POP Account and Return Address to reflect the 
new mailbox name (i.e. change the portion to the left of the 
"@" symbol).  You can also change the Real Name to 
whatever you want.

8 Once you have configured Eudora for the new mailbox, close 
Eudora.

9 To add an icon to the Launch It! toolbar,  refer to the table on 
page 51.

What's Next
The next chapter, Getting Started, will tell you about the PipeLine+ Access Panel 
and its configuration screens.



Chapter 3
Getting Started

This chapter describes:

· The PipeLine+ Access Panel where you connect to MindSpring and launch your Internet 
applications.

· The configuration screens where you can change user information, modem settings, enable 
password security, and configure the tool panel.

Chapter Table of Contents
This chapter includes the following sections:

Section Page
Using the PipeLine+ Access Panel (Windows) 37
Connecting to the Internet (Windows) 39
The PipeLine+ Configuration Screens (Windows) 39
Configuring the Windows 95 Dialer 45
Using the PipeLine+ Access Panel (Macintosh) 50
Connecting to the Internet (Macintosh) 52
The PipeLine+ Configuration Screens (Macintosh) 52



Using the PipeLine+ Access Panel  (Windows)
Congratulations!  The PipeLine+ software is installed, and you are ready to connect
to MindSpring.  Before you connect, take just a few minutes to familiarize yourself
with the PipeLine+  Access Panel.
From the MindSpring Program Group box, double-click the MindSpring icon to 
open the PipeLine+  Access Panel.

Figure 1:  PipeLine+ Access Panel for Windows

The following table will acquaint you with the buttons, icons, and information 
areas on the Access Panel:

Buttons, Icons, and 
Information Areas Description

Connect Connects and disconnects from MindSpring.
Daily Announcement Displays a daily message to you from MindSpring 

when you connect.
Help Accesses the MindSpring-specific help files.
Configure Allows you to re-configure certain preferences in your 

PipeLine+ software.  
Acc’t Info Opens your web browser, and brings you directly to the

MindSpring Account Info web page. You can 
determine your bandwidth and disk space usage from 
here.

Display Usage 
Statistics

Opens your web browser, and brings you directly to the
MindSpring Account Usage page. 

Status information 
on the bottom line

Displays:
· Envelope in left corner indicates that you have new mail
· Disconnect/connect status
· Username
· IP address returned dynamically
· Time and date
· A clickable ? (question mark) for viewing version 

information about the PipeLine+ software

The Tool Panel



Buttons, Icons, and 
Information Areas Description

Executes Microsoft Internet Explorer for browsing the 
World Wide Web.

Executes the Eudora Light e-mail program.

Executes the Free Agent newsreader for accessing 
Usenet and newsgroups.

Executes mIRC for accessing Internet Relay Chat.

Executes WS_FTP for downloading or uploading files.

Opens a search engine for the WWW.

Executes a Web Guide for navigating the WWW.

Executes the MindSpring Community content via the 
WWW.



Buttons, Icons, and 
Information Areas Description

Displays the list of MindSpring’s dial-in cities.

Executes the MindSpring Help Desk via the WWW.

Connecting to the Internet (Windows)
Now, you are ready to connect to MindSpring.  From the PipeLine+ Access Panel, 
simply click the Connect button, and the following events occur:
· Your modem dials MindSpring.
· The software connects your computer to MindSpring.
· The Connect button text changes, to Disconnect and a "Connected" message 

appears.  
· MindSpring's daily announcements appear on the panel and, if you have new 

mail, a notification appears.
You can now click on any of the client applications to connect to the Internet.

Note:  Do not double-click the buttons on the PipeLine+ Access Panel.  Double 
clicking these buttons is like double clicking the power button on a TV

The PipeLine+ Configuration Screens (Windows)
The PipeLine+ Configuration screens are used to maintain software configuration 
settings, such as:
· User information
· Modem configuration (Windows 3.1 or 3.11 only)
· Mail options
· Tool panel
· Miscellaneous settings
When you click the Configure button on the PipeLine+ Access Panel, the 
PipeLine+ Configuration tabbed screens appear.  The screens are described in the 
following sections.



User Information Screen (Windows)
To change any information about your MindSpring account, use the User Info 
screen, as shown in Figure 2.

Figure 2:  User Info screen (Windows)

These fields define your individual Dial-Up account.  The information included 
here is critical to getting connected to the Internet (except for the Full Name, which
can be anything you want).
Full Name - Type your full name.
User ID - Be sure to type your user ID in lowercase letters.
User Pass: Type your mailbox password (each character you type appears as an 
asterisk on the screen to protect the confidentiality of your password).
Mailbox Name - Type your mailbox name in lowercase letters.
Mailbox Pass - Type your mailbox password (each character you type appears as 
an asterisk on the screen to protect the confidentiality of your password).
State/Cntry/Prov - Select your state, country, or province from the list box.
City - Select your city from the list box.
Conn Type - Select a connection type from the list box.
Domain (Windows 95 only) - This information is added during installation, but can
be modified (see Modify Application Settings).
Modem (Windows 95 only) - Will display your modem type here. 
Area Code (Windows 95 only) - This information is added during Setup, but can 
be modified.
Access # (Windows 95 only) - This information is added during Setup, but can be 
modified.
Dial Prefix (Windows 95 only) - If you must dial a prefix before the access 
number, such as 9 for an outside line, select the dial prefix from the list box.  
Use Area Code (Windows 95 only) - Check this box if you must dial an area code 
to call the access number.
Use Dial Prefix (Windows 95 only) - Check this box if you must dial a prefix 
before the access number. (For example if you must dial 9 for an outside line).
Enable Password Security -  Check this box if you would like to password protect
your MindSpring access.  If the box is checked, you will be required to enter your 
password before dialing up MindSpring.



Modify Application Settings - When checked, this feature changes your e-mail 
address or mail/server configuration to match and POP changes you have made in 
this configuration.

Modem Configuration Screen (Windows 3.1 and 3.11 only)
To change any information about your modem, use the Modem Configuration 
screen, as shown in Figure 3.  These fields define the modem settings.  The 
combination of the Init string and Speed are important when your modem and our 
modem try to negotiate a connection.

Figure 3:  Modem Configuration screen (Windows 3.1 and 3.11 only)

Modem - If your modem has changed from your original configuration, select your
new modem (brand, type, and speed, if available) from the drop down list.  If your 
modem is not on our list, choose Default Modem Settings.
Init String - The initialization string is automatically filled in.  
Comm Port - This is the Comm port for your modem.  Most modems are on 
Com2, and the mouse is on Com1.  Refer to your computer's documentation to be 
sure.

Baud Rate - If you have a 14.4 kbps modem, select 19,200.  If you have a 28.8 
kbps modem, select 38,400.
Area Code - This information is added during Setup, but can be modified.
Access # - This information is added during Setup, but can be modified.
Dial Prefix - If you must dial a prefix before the access number, such as 9 for an 
outside line, select the dial prefix from the list box.  
Use Area Code - Check this box if you must dial an area code to call the access 
number.

Helpful Tip
Click the Discover Comm Port button if you want the PipeLine+ software to find 
the Comm Port for you.  If the software does not dial out after initializing, then 
you’ve most likely chosen the incorrect Comm Port.



Mail Options Screen (Windows)
The fields on the Mail Forwarding screen, as shown in Figure 4, allow you to 
configure mail forwarding options while online, such as "on vacation".  See the 
MindSpring web page at http://www.mindspring.com/ for details.

Figure 4:  Mail Options screen (Windows)



Tool Panel Screen (Windows)
Tool Panel icons are configurable.  For instance, you can change to your favorite 
web browser and then access it from the PipeLine+ Access Panel.  To demonstrate 
how to do this, refer to the following section - Example Button Reconfiguration.

Figure 5:  Tool Panel screen (Windows)

Example Button Reconfiguration
· From the PipeLine+ Access Panel, click the Configure button.
· From the PipeLine+ Configuration screen, select the Tool Panel tab.
· At the Tool Panel Configuration screen, as shown in Figure 5, select the button

you want to configure.  In this example, let’s assume you have 
downloaded a new mail program called Pegasus Mail and want to 
reconfigure the mail button to launch Pegasus instead of Eudora Light.  
First, you would click the Mail icon to associate with the Pegasus program.

· Choose the Find Target button.  A dialog box appears.
· Find and select the executable (*.exe) file that you want assigned to the Mail 

button.  (In this example, the executable file is pegasus.exe.)  The 
executable filename appears in the App (Application) Path field.

· Click OK.

· Enter the label that you would like to show on the button in the App Desc 
(Application Description) field.  (In this example, the label is Pmail.)  You
are limited to six characters.  Click OK.

· The Tool Panel Configuration screen appears again.  Click OK.
· The PipeLine+ Configuration screen appears.  Click Save.
· You can now launch the Pegasus Mail whenever you click the Mail button.  To

configure the Mail button to execute Eudora again, repeat the above steps 
using Eudora.EXE.  Use this procedure to configure any of the buttons on 
the Tool Panel.

Miscellaneous Settings Screen (Windows)
These fields allow choices for sound alerts, mail and message check preferences, 
dialer settings, and DNS entries.  You may change these as you like.  



Figure 6:  Miscellaneous Settings screen (Windows)

Warning: 
While the DNS  numbers above may not reflect the numbers on your screen, 
please do not change the DNS numbers unless instructed to by MindSpring.



Configuring the Windows 95 Dialer
PipeLine+ for Windows 95 uses Dial-Up Networking (DUN) to connect to 
MindSpring.  Since the PipeLine+ installation configures DUN for you, you can 
skip this section if you are going to use the Access Panel to connect.  If you choose 
not to use the Access Panel, you can use Dial-Up Networking to establish your 
connection.  If you are a Windows 3.1 user and have just migrated to Windows 95, 
you can configure DUN to connect, and use all of the applications that shipped 
with your Windows 3.1 software.

Note:  If you are on a local area network (LAN) and install DUN, you may create a
conflict which interrupts your computer's connection to your LAN.  Please ask your
network administrator for assistance before installing Dial-Up Networking (DUN).

Before you install DUN, you will need your Windows 95 disks or CD-ROM.

Adding the Dial-Up Networking Component
Follow these steps to add the Dial-Up Networking component to your Windows 95 
configuration:

Step Action

1 From your desktop, double click My Computer.  You should 
see icons for the drives on your system, Control Panel, and, if 
it's installed, Dial-Up Networking.

· If Dial-Up Networking is installed, skip to Setting Up Windows 95
for TCP/IP, on page 46.  

· If Dial-Up Networking is not installed, go to Step 2.

2 Double-click Control Panel.

3 Double-click Add/Remove Programs.

4 Click the Windows Setup tab.

5 Double-click the Communications component.

6 Select the Dial-Up Networking component so that it is checked 
at the left.

7 Click OK.

Step Action

8 Click OK again.  Windows 95 begins copying files from your 
Windows 95 disks.  Insert the proper disk or your CD-ROM 
when prompted to do so.

9 After Windows 95 copies the DUN files, a window appears 
stating that you need to enter a computer and workgroup 
name.  Click OK.

The Network Identification dialog box appears.

10 Type your first name in the Computer Name field and your 
last name in the Workgroup Name field, and click Close.

More files are copied from your Windows 95 installation 
media.   A message appears stating that you must restart your 
computer when Add/Remove Programs is complete.



Step Action

11 Click OK.  When Add/Remove Programs finishes copying 
files, the Control Panel appears.

12 To restart you computer,  do the following:

· Click the Start button.
· Click Shutdown.
· Select Restart the computer
· Click Yes.

13 When your computer restarts, the system prompts you to enter 
your username and password for Windows Networking.  Do 
the following:

· Type your MindSpring username in the Username field.
· Leave the Password field blank.
· Click OK.
A window appears prompting you to verify your password.

14 Leave everything blank and click OK.

Note:  The next time you restart Window 95, the system will 
not prompt you to enter a username and password.  You will 
also notice a new icon on your desktop named Network 
Neighborhood.  This icon is just part of the networking 
component in Windows 95.

You have now successfully installed the Dial-Up Networking component of 
Windows 95.  When you are ready to continue, go to the next section, Setting Up 
Windows 95 for TCP/IP.

Setting Up Windows 95 for TCP/IP
Follow these steps to install TCP/IP networking for Windows 95:

Step Action

1 From your desktop, double-click My Computer.

2 Double-click Control Panel.

3 Double-click Network.

· If Microsoft's TCP/IP Protocol is not installed, go to Step 4. 
· If the TCP/IP Protocol is already installed, go to Setting Up Dial-

Up Networking on page 56.

4 Follow these instructions to add TCP/IP:

· Click Add, and then double-click Protocol.  The Select Network 
adapters screen appears.

· Scroll down the list of Manufacturers and select Microsoft.
· Select TCP/IP.
· Click OK.

5 You have configured Windows 95 for TCP/IP networking.

· Click OK.
· Click OK again.
More files are copied from your Windows 95 disks or CD-
ROM.



Step Action

6 When the system prompts you to restart your computer, click 
Yes.

When you are ready to continue, go to the next section, Setting Up Dial-Up 
Networking.

Setting Up Dial-Up Networking
Follow these steps to set up dial-up networking:

Step Action

1 From your desktop, double-click My Computer.

2 Double-click the Dial-Up Networking folder.

3 Double-click Make New Connection.

4 Enter a name for the connection (e.g. MindSpring).

5 Select your modem from the drop-down list.

6 Click Next.

7 Enter your local MindSpring access telephone number.

Note:  If you need to dial the area code, but not a "1" to 
connect to MindSpring, type the entire 10-digit number in the 
Telephone Number field.  DO NOT put the area code in the 
Area Code field.   Also, if you need to disable call waiting, 
type *70, in front of the telephone number.

For example,  if you are within the local calling distance of 
Atlanta,  but must dial the area code (404) and you also have 
call waiting, you would type the following in the Telephone 
Number field:

*70,404-654-1300
8 Click Next, and then Finish.

Next, you need to check your global TCP/IP settings.
Note:  If you are on a local area network, please ask your network administrator for
assistance before making these changes.  You should not modify the TCP/IP setting
for your Network Adapter.
Follow these steps to check your global TCP/IP settings:

Step Action

1 Go back to My Computer and double-click Control Panel.

2 Double-click Dial-Up Networking.

3 Double-click TCP/IP (or TCP/IP –> Dial-Up Adapter).



Step Action

4 Click the DNS Configuration tab, and select Disable DNS.

5 Click the IP Address  tab, and then Obtain IP Address 
Automatically.  

6 Click the Gateway tab.  If you have a gateway already 
installed, select the Gateway Address and then click Remove.

7 Click OK.

8 Click OK again.  If you are prompted to restart your computer,
click Yes. 

When you are ready to continue, go to the next section, Configuring the 
MindSpring Dial-Up Networking Connection.

Configuring the MindSpring Dial-Up Networking Connection
Follow these steps to set up your newly created DUN icon to connect to 
MindSpring:

Step Action

1 From the desktop, do the following:

· Double-click My Computer.
· Double-click Dial-Up Networking.
· Right-click the MindSpring icon you created earlier and select 

Properties.

2 Click the Server Type button.  Make sure the Type of Server 
reads PPP: Windows 95, Windows NT 3.5, Internet.

3 In the Advanced options  section, select Enable software 
compression.  Deselect the others, if checked.

4 In the Allowed network protocols  section, only  TCP/IP should 
be selected.  

Note:  Selecting other protocols may reduce the speed of your 
connection or make a connection impossible.   If you are on a 
local area network (LAN), please consult your network 
administrator.

5 Press the TCP/IP Settings... button.

Step Action

6 Do the following:

· Select Server Assigned IP.
· Select Specify name server addresses.   Enter, in this order, the 

name server addresses:
· Primary DNS:  207.69.188.185

Secondary DNS:  207.69.188.186
Primary WINS:  0.0.0.0
Secondary WINS:  0.0.0.0

· Select Use IP header compression.
· Select Use default gateway on remote network.
· Select OK.

7 Click OK.



Step Action

8 Select OK again.

9 Do the following to create a shortcut on the desktop to 
connect to MindSpring:

Select your new MindSpring connection icon.

· Click and drag the icon to the desktop.  

· When prompted, choose Create Shortcut.

CONGRATULATIONS!
Your Dial-Up Networking connection is configured.  Go to the next section,
Logging In to MindSpring, to login.

Logging In to MindSpring
Follow these steps to login:

Step Action

1 To login to MindSpring, double-click the Shortcut to 
MindSpring icon on the desktop.  A window appears prompting
you to enter your username and password.

2 Type your username in the Username field,  and your password
in the Password field.  

Step Action

3 Click Connect.

You will hear the modem dial and the Connecting to 
MindSpring window appears with a timer counting up from 
zero, showing how long you've been connected.  

You can now run any Internet software you choose, including the client software 
included from MindSpring.  Just minimize the Connected to MindSpring window, 
and launch your Internet applications manually.  
Note:  When using Dial-Up Networking, you can use all the software provided by 
MindSpring except for the Access Panel.  Running the Access Panel while using 
DUN will create a conflict and it will not work.
MindSpring can offer support only for those programs that came with PipeLine+.  
If you have problems getting an Internet application to work with DUN that is not 
part of PipeLine+, please contact the manufacturer of that program for assistance.



Using the PipeLine+ Access Panel  (Macintosh)
Congratulations!  You have installed the PipeLine+ software for the Macintosh.  
Before you connect to MindSpring, take just a few minutes to familiarize yourself 
with the PipeLine+ Access Panel.
Double-click the MindSpring’s PipeLine+ icon located in the MindSpring’s 
PipeLine+ folder, to open the PipeLine+ Access panel.  

Figure 7:  PipeLine+ Access Panel for Macintosh

Adding the MindSpring’s PipeLine+ Icon to the Menu
For easy access, you may want to put MindSpring’s PipeLine+ in your Apple 
Menu, so you can open the PipeLine+ Access Panel just by selecting it from 
the menu.  Follow these steps:

Step Action

1 Open your MindSpring folder and single-click on the 
MindSpring’s PipeLine+ icon.

2 Select Make Alias from the Finder’s File menu.  The alias will 
appear next to the MindSpring’s PipeLine+ icon.

Step Action

3 Open your System Folder and locate the Apple Menu Items 
folder.   Simply drag the alias to the Apple Menu Items folder.  
(You may want to go into your Apple Menu Items folder and 
take “alias” off the name; it will appear in the menu exactly as
it is named in the folder.)

The following table will acquaint you with the buttons, icons, and information 
areas on the Access Panel:

Buttons, Icons, and 
Information Areas Description

Connect/Disconnect Connects and disconnects from MindSpring.
Configure Allows you to re-configure certain preferences in your 

PipeLine+ software.



Account Info Opens the Netscape Navigator software, and brings you
directly to the MindSpring Account Info web page.  
You can determine your bandwidth and disk space 
usage from here.

Search User 
Directory

Opens the Netscape Navigator software, and brings you
directly to the MindSpring User Search Tool.

Daily 
Announcements

Displays messages to you from our staff when 
connected to MindSpring.

Month’s Usage Displays the amount of time you have been connected 
since the first day of the current month.   This is 
updated once every 24 hours.

Messages Waiting Displays the number of mail messages you have 
waiting to be downloaded.  To check for mail again, 
click on the red flag, or select Check Mail from the 
File menu.
Executes Netscape and takes you directly to the Yahoo 
search engine (also found on Launch It! Toolbar).

Executes Netscape and takes you directly to the 
MindSpring Web Pages.

Executes Netscape and takes you directly to the 
MindSpring Help Desk Web Pages for Technical 
Support.
Executes Netscape and takes you directly to the 
MindSpring Home Page

Buttons, Icons, and
Information Areas Description

Launch It! 
Toolbar

When you first install PipeLine+, the toolbar displays the 
following six icons (you can add other icons if you want):
Lets you customize the Launch It! Toolbar.  To add an 
icon to the toolbar, click on the plus sign, then use the file
selection dialog box to select the application or document
you want to add (you can’t add aliases).
When you press the Option key, the plus sign changes to 
a minus sign.  To remove an icon from the toolbar, 
Option-click on the minus sign and use the dialog box 
that appears to select the icon you want to remove.  
If you have System 7.5 or higher, or the Mac Drag and 
Drop extension, you can drag an icon from the Finder to 
the plus sign to add it, or Option-drag an icon from the 
toolbar to the minus sign to remove.  
Executes Anarchie, for performing Archie searches and 
downloading or uploading files.

Executes the Netscape Navigator software for browsing 
the World Wide Web. 
Executes NewsWatcher newsreader for accessing Usenet 
and newsgroups.
Executes Homer for accessing Internet Relay Chat. 

Executes Fetch for File Transfer Protocol (FTP) or 
downloading/uploading files.

Executes the Eudora Light e-mail program.



Note:  If you don’t have System 7.5, and want the Drag and Drop extension, you 
can download it from the following Web site (type this URL into Netscape’s 
Location field): http://www.info.apple.com/

Connecting to the Internet (Macintosh)
Now, you are ready to connect to MindSpring.  From the PipeLine+ Access panel, 
simply click the Connect button, and the following items occur:
· Your modem dials MindSpring.
· The software connects your system to MindSpring.
· Daily announcements and mail waiting appear on the Access Panel.
You can now click on any of the Internet client applications.

The PipeLine+ Configuration Screens (Macintosh)
The PipeLine+ Configuration screens are used to maintain and modify 
configuration information, such as:
· Access preferences
· User information
· Modem configuration
· Server and domain name information

If you want to... Select this option...
Configure the launch actions Preferences from the Edit menu.

Change your password Change Password from the File menu.
Modify other settings Configure Apps from the File menu.

The various settings are described in the following sections.

PipeLine+ Preferences (Macintosh)
To change any information about your PipeLine+ preferences, select Preferences 
from the Edit menu.  The PipeLine+ Preferences window appears, as shown in
Figure 8.

Figure 8:  PipeLine+ Preferences window (Macintosh)

Open connection on Launch - Select if you want to connect to MindSpring 
automatically when you launch the access panel.
Close connection on Quit - Select if you want to disconnect automatically when 
you quit the access panel.
Check Mail - Select if you want to automatically check for new mail when you 
connect to MindSpring.



Check Usage and Message of the Day - Select if you want to automatically check
your usage and see the Message of the Day when you connect to MindSpring.

Set Password (Macintosh)
To change your password, select Change Account Password from the PipeLine+ 
file menu.  The Set Password window appears, as shown in Figure 9. 

Figure 9:  Set Password window (Macintosh)

To change your password:
· Be sure you are connected to MindSpring.
· Type your current password in the Old Password field, then type your new 

password in both the New Password and Verify Password fields.  
· Click on OK.  You will see an error message if you didn’t type your old 

password correctly, or if your entries in the New Password and Verify 
Password fields don’t match.  
Otherwise, you will see a message telling you that your password has been
changed.  It will take a few minutes for your new password to be 
processed.  The next time you connect, you may see a dialog box asking 
for your User ID and password.  If your new password hasn’t been 
processed yet, it may tell you your new password is wrong.  Wait a while 
and try again.

Connection Settings (Macintosh)
To change any information about your connection settings, select Configure 
Applications from the PipeLine+ file menu or select the Configure button directly 
from the Access Panel.  The PipeLine+ Connection Settings window appears, as 
shown in Figure 10. 



Figure 10:  Connection Settings window (Macintosh)

Location - This is the location you picked during setup.  You can change this if 
you travel to any other local dial-up location.
Service Type - This is the connection type you picked during setup.  You can 
change this.  [V.34 (modem), ISDN (64k), 2B ISDN (128k)]
Phone Number - This is your dial-up number automatically displayed, based on 
the dial-up location you selected during setup. 
Modem Init - This is the initialization string you chose during setup or provided by
your PPP preferences.  If your connection isn’t as fast as you think it should be, 
refer to your modem documentation to determine an alternate string to try.
Serial Port - This is the port you selected during setup.  Change it only if you 
move your modem connection to a different port.
Flow Control - Defaults to hardware flow control (CTS & RTS).  Refer to your 
modem documentation for more information.
Speed - This is the modem speed which depends on your modem.
User ID - This is the username your typed during setup.  Don’t change this; it 
should remain just as it appears in your welcome letter!
Password - Don’t try to change your password here!  This field should display your
current valid password.  Your password is in your welcome letter, along with your 
other account information.  

Identity and E-mail Settings (Macintosh)
To change any information about your identity and e-mail settings, select 
Configure Applications from the PipeLine+ file menu or select the Configure 
button directly from the Access Panel.



Figure 11:  Identity and E-mail Settings window (Macintosh)

Real Name - The is your full name.
Organization - This is an optional data field for your organization or company 
name.
E-mail Address - This is the e-mail address you selected and is provided with your
account information in your welcome letter.
Mail Password - This is the password for your mailbox.
Domain Name - This is the domain name you chose during setup.  Your domain 
name should correspond with the end of your e-mail address.

Usenet News Settings (Macintosh)
To change any information about your Usenet News Settings, select Configure 
Applications from the PipeLine+ file menu or select the Configure button directly
from the Access Panel.  The Usenet News Settings window appears, as shown in
Figure 12.  

Figure 12:  Usenet News Settings window (Macintosh)

World Wide Web Settings (Macintosh)
The software is pre-configured to the MindSpring home page.  To change the 
default home page in your web browser, select Configure Applications from the 
PipeLine+ file menu.  The World Wide Web Settings window appears, as shown in
Figure 13.  



Figure 13:  World Wide Web Settings window (Macintosh)



Chapter 4
The Netscape Navigator Software

This chapter introduces Netscape Navigator, a popular web browser for navigating the World Wide 
Web which is provided with MindSpring PipeLine+ for the Macintosh.  It covers:

· Launching Netscape Navigator

· Netscape Navigator menu options

· Frequently Asked Questions (FAQs) about Netscape Navigator

· How to find the Netscape Navigator online handbook and help
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Using Netscape Navigator (Macintosh only)
One of the hottest areas of the Internet is the World Wide Web.  To access the 
Web, you need a viewing tool called a web browser.  MindSpring provides a 
licensed version of Netscape Navigator for browsing the sites on the World Wide 
Web.
Netscape Navigator also allows users to send and receive e-mail, read and post to 
thousands of newsgroups, listen to sounds, view animations, transfer files, and 
order products and services for home or business without leaving the program.  Use
the following information only as a brief description of the many options, 
preferences, and capabilities of the Netscape Navigator.

Notice:  Netscape Navigator is a commercial product licensed to you through 
MindSpring.  DO NOT distribute Netscape Navigator; it is NOT shareware or 
freeware.

Launching Netscape Navigator
· To launch Netscape Navigator,  click the Netscape Navigator button on the 

Launch It! Toolbar.

You will enter the World Wide Web at the MindSpring web page, as shown in
Figure 14

 
Figure 14:  MindSpring web page



Getting Started
From the MindSpring web page, choose any of the following suggestions to get 
started:
· Click on any blue underlined text, called a link, and you are transported to a 

Web page anywhere on the global Internet.  These links (originally called 
hyper-links) are the key to navigating the World Wide Web.

· Click on the Netscape Navigator logo to access the Netscape 
Communications web page.

· Click the What's New or What's Cool button, and you are presented with a 
variety of interesting links.

· Click the Destinations button, and you are presented with a site dedicated to 
the latest Netscape technology.

· Click the Net Search button, and you are introduced to several search engines 
where you can look up any topic imaginable.

· Choose Handbook from the /  menu if you need help while learning how
to use Netscape Navigator.  The Netscape Navigator Handbook provides 
complete information about using the Netscape Navigator program.

· Click the Home button on the toolbar to return to MindSpring's home page. 

Using The Toolbar Buttons
The following list explains the toolbar buttons that perform some of the most 
common tasks in the Netscape Navigator software.
Back – Displays the previous page in the history list.  A history list references a 
hierarchy of pages you've already viewed. 
Forward – Displays the next page in the history list.  Forward is available only 
after you use Back or a history item. 
Home – Displays the home page designated in the General Preferences | 
Appearance panel.  The default is the MindSpring home page location. 
Reload – Redisplays the current web  page, reflecting any changes made prior to 
the original loading, if any change to the page has occurred.  If you choose Reload 
from the View menu while holding down the Option key, Netscape Navigator 
retrieves the page from the network server regardless of whether the page has been 
updated.
Images – Loads images into pages.  This is useful when the Options | Auto Load 
Images menu item is unchecked and icons have been substituted for images. By 
loading images, you replace the icons with the intended images. 
Open – Lets you enter a URL to display the specified page in the content area. 
Print – Prints the content area of the current web page you are viewing.  A dialog 
box lets you select printing characteristics. 
Find – Lets you specify a word or phrase to locate within the current web page you 
are viewing.  You can specify case sensitivity and search direction.  If a match is 
found, the text is selected and displayed. 
Stop – Halts any ongoing transfer of page information. 

Using the Directory Buttons
The following list explains the directory buttons that let you quickly access 
Netscape Navigator's popular directories and other significant Netscape Navigator 
information:
What's New? – Information describing what's new on the Internet. 
What's Cool? – Information describing what's cool on the Internet. 
Destinations – A site dedicated to the Latest Netscape technology. 
Net Search – A directory of Internet search engines. 
People – A listing of people finders. 
Software – Information on Netscape Navigator software upgrades. 



Note:  Directory buttons can also be accessed from the Directory or Help menus. 

Using the Menu Options
The following list briefly describes each of the Netscape Navigator menu options.  
This list is provided only as quick reference information.  For complete instructions
on learning and using Netscape Navigator, refer to the online Netscape Navigator 
Handbook.

The File Menu
New Web Browser – Creates a new window with the same history 
items as the previous window while bringing the oldest page in the 
history (usually the home page) to screen.
New Mail Message – Produces a Mail Document dialog box that lets 
you send a mail message and page attachment.
Mail Document (or Mail Frame...) – Produces a Mail Document 
dialog box that lets you send a mail message with the text of the 
current document (or frame) as the body text or as an attachment.
Open Location... – Produces a dialog box that lets you enter a 
Uniform Resource Locator (URL) to bring the specified page into the 
content area.  Every page has a unique URL that identifies its 
protocol, server, and file pathname.
Open File... – Lets you select a file to open from a dialog box.
Save As.. (or Save Frame As...) – Creates a file whose content is the
content area of the current Netscape Navigator page.  A dialog box 
lets you select the file's format.
Upload File – Lets you select a file to upload to the FTP server 
specified by the current URL.  The command is only active when the 
current page accesses an FTP site.  Alternatively, you can upload files
to the FTP site by dragging and dropping files from the desktop to the
Netscape Navigator window.  Write permission is required. 
Page Setup.. – Lets you specify printing characteristics associated 
with the current page. 
Print (or Print Frame...) – Prints the content area of the current 
Netscape Navigator page.
Close – Closes the current Netscape Navigator page 
Quit – Closes the current Netscape Navigator page and exits the 
Netscape Navigator application. 

The Edit Menu
Undo – Reverses the last action you performed, if possible.
Cut – Removes the current selection and places a copy on the 
clipboard. 
Copy – Places a copy of the current selection on the clipboard.
Paste – Puts the contents of the clipboard into the current Netscape 
Navigator page at the position of the selection marker.
Clear – Removes the current selection.
Select All – Selects the entire document.
Find – Lets you specify a word or phrase to locate within the current 
Netscape Navigator page.  Press the Find button to begin the search.  
If a match is found, the text is selected and scrolled to a visible 
position in the content area.  
Find Again – Searches for another occurrence of the text specified 
after using Find.



The View Menu
Reload – Redisplays the current Netscape Navigator page, reflecting
any changes made prior to the original loading, if any change to the 
page has occurred.  If you press the Reload button while holding 
down the Option key, Netscape Navigator retrieves the page from 
the network server regardless of whether the page has been updated.
Reload Frame – Brings a fresh copy of the currently selected page 
within a single frame on a Netscape Navigator page containing 
frames. 
Load Images – Displays the images of the current Netscape 
Navigator page.  Typically, images automatically load into pages.  
However, if Auto Load Images from the Options menu is 
unchecked when a page loads, a small icon is substituted at the 
position of each image.  Choosing Load Images replaces all of the 
small icons with their corresponding images.  Images are loaded 
from their source files, however the page is not reloaded (links to 
images are not updated from the source page).

Document Source – Produces a View Source dialog box containing 
a page in the HTML (HyperText Markup Language) format rather 
than the standard format.  The HTML format represents the source 
document used to create the content and content style of a page.  
Document Info – Produces dialog box containing information about 
the current document such as included images, date of last 
modification, length, location, and security status.

The Go Menu
Back – Displays the previous page in the history list.  A history list 
is a reference to a hierarchy of pages you have viewed. 
Forward – Displays the next page in the history list.  The Forward 
command is only offered after using Back or a history item.
Home – Displays the home page whose location is specified in the 
General Preferences | Appearance panel.  MindSpring's web page,
http://www.mindspring.com/, is the default.
Stop Loading – Halts the connection in progress that is bringing a 
page to the screen.

The Bookmarks  Menu

Add Bookmark – Adds the title of the current Netscape Navigator 
page to the list of pages in the bookmark file.  Bookmarks are stored
as a list and represented by a bookmark file on your hard disk.  The 
bookmarks list can be viewed in the Bookmarks window. 

The Options Menu
General Preferences... – Presents a dialog box containing tab 
buttons for selecting preference items.  Each tab presents one or 
more panels that help you define Netscape Navigator's operation.  
The General Preferences panels cover a broad set of preference 
items.  Panels for other preference items are displayed by subsequent
menu items.  
Mail and News Preferences... – Presents the tabbed panels for 
setting mail and news preference items. 
Note:  In order to send mail directly from Netscape Navigator, you 
should enter your name and your e-mail address in their respective 
fields located under the Preferences - Mail and News dialog box.
Network Preferences... – Presents the tabbed panels for setting 
preference items regarding cache, network connections, and proxy 



configurations. 
Security Preferences... – Presents the tabbed panels for setting 
preference items for security features. 
Show Toolbar – Toggles the visibility of the toolbar buttons.  If 
checked, the toolbar buttons are visible. 
Show Location – Toggles the visibility of the location (URL) field. 
If checked, the location is visible. 
Show Directory Buttons – Toggles the visibility of the Directory 
menu buttons.  If checked, the buttons are visible. 
Show Java Console (Windows only)  – Displays the Java Console 
window.  Some Java programs might display information here. 
Auto Load Images – Toggles the presentation of in-line images as a
page is brought to screen.  If checked, images embedded in a page 
are automatically loaded.  If unchecked, images are not loaded and 
are instead represented by small icons that can be loaded by 
choosing View | Load Images or Images from the toolbar.  
Unchecking this item increases the speed for displaying page text. 
Document Encoding – Lets you select which character set encoding
a document uses when document encoding is either not specified or 
unavailable.  The proportional and fixed fonts associated with the 
default encoding are designated using the General Preferences | 
Fonts panel items. 
Save Options – Saves any changes made to the settings of the 
Options menu (not including the preferences panels whose items are
saved by pressing OK).  Changes remain in effect for subsequent 
Netscape Navigator sessions. 

The Directory Menu
Netscape Home – Netscape Navigator Communications Home Page
on the Web.  Also available by clicking on the Netscape icon 
located in upper right corner of the window.
What's New? – Information describing what's new on the Internet.
What's Cool! – Interesting pages on the Internet. 
Customer Showcase Features companies that are using Netscape 
Servers to promote their businesses.
Netscape Destinations – A showcase of Netscape Technology.
Internet Search – A directory of Internet search engines. 
People – A directory of services to help you locate an Internet 
member. 
About the Internet – An explanation of the Internet with links to 
interesting items.

The Window Menu
Netscape Mail – Opens the Netscape Navigator e-mail window.
Netscape News – Opens the Netscape Navigator news reader 
window.
Address Book – Displays an Address Book window where you can 
create and modify files containing e-mail addresses. 
Bookmarks – Displays a Bookmarks window where you can create 
and modify bookmark files. 
History – Displays a History window that lists, in two columns, the 
title and URL of each page you have recently viewed.  The history 
list is sorted with the most recently viewed pages at the top.  One 
item in the list is always selected.  Pressing the Go to button, or 
double-clicking an item, brings the selected page back to the screen. 
Pressing the Add to Bookmark button puts the selected page into 
the bookmark list. 



/  Menu

About Netscape – Version, copyright, and license information 
about the Netscape Navigator software. 
Registration Information – Displays a page containing the 
registration number for your copy of Netscape Navigator.  If you 
have not yet registered your copy of the software, the page tells you 
how to register.  
Handbook – Displays the online version of the Netscape Navigator 
documentation, with links to chapters and index entries.  
Release Notes – New feature information, links to helper 
applications, and tips for using a specific version of the software. 
Frequently Asked Questions – Answers to common questions on a 
variety of Netscape Navigator topics. 
On Security – Questions and answers about Netscape Navigator's 
security features and links to additional technical information about 
Netscape Navigator's implementation of Internet security. 
On Usenet News – A quick guide to participation in newsgroups.
How to Give Feedback – A feedback form for you to fill in and 
send your comments, requests for features, bug reports, and other 
information to Netscape Navigator. 
How to Get Support – Displays information on Netscape Navigator 
support programs and relevant e-mail addresses. 
How to Create Web Services – A page with links to help you 
explore opportunities for creating and publishing your own 
documents on the Internet using Netscape Navigator software. 

Using the Mouse Button Shortcuts
By holding down the mouse button on a window, a pop-up menu appears with 
items that are shortcuts for several commands.
The items shown in the pop-up menu depend on the type of contents your mouse is 
pointing to on the window.  For example, when pressing the mouse button over a 
link, menu items refer to the page specified by the link; over an image, menu items 
refer to the image file specified by the image; over a pane in the Mail or News 
window, menu items apply specifically to mail or news features.  When a frame is 
selected, Back and Forward menu items refer to the individual frame. 

Back  (Same as Go | Back item) – Displays the previous page 
in the history list. 
Forward (Same as Go | Forward item) – Displays the next page
in the history list. 
Open this Link – Displays the specified page. 
Add Bookmark for this Link – Creates a bookmark in the 
bookmark list for the specified page. 
New Window with this Link – Displays the specified page into a
newly opened window instead of the current window. 
Save this Link as... – Saves the specified page to disk (instead 
of displaying on screen). 
Copy this Link Location – Copies the specified page location 
(URL) to the clipboard. 
Open this Image – Displays the specified image. 
Save this Image as... – Saves the specified image to disk 
(instead of displaying on screen). 
Copy this Image – Copies the specified image to the clipboard. 
Copy this Image Location – Copies the specified image 
location (URL) to the clipboard. 
Load this Image – Displays the specified image.  (Replaces an 



image icon with the corresponding image like the View | Load 
Images menu item).

FAQs about Netscape Navigator

What is a URL?
A URL (Uniform Resource Locator) is an Internet "address".  Each Web page has a
unique URL.  Because URLs can often be long and difficult to remember or to 
type, the Copy, Paste, and Save As commands are commonly used when dealing 
with URLs.

What do the Back, Forward and Home buttons do?
Each time you start a Web session, Netscape Navigator keeps track of where you've
been.  Clicking Back and Forward moves you through the list of places you've 
been, one at a time.  Home returns to the MindSpring home page.  Note that once 
you've clicked a link, it changes from blue to purple to help you keep track of 
where you've been.  You can change how long the links stay purple in the Options 
section.

Sometimes I click on a link and nothing happens . . . for a long time.
There are many reasons why this might happen.  The site you are trying to visit 
could be really busy or undergoing updating or repairs.  Occasionally, the Web 
seems to get hung up.  The best thing to do is to press STOP, then press the Reload
button and see if you can connect.  If not, consider it a "no answer" and try again 
later.

Can I get Netscape Navigator to remember a place I like so I can visit it again later?
When you're viewing a site that you want to remember, click Bookmarks | Add 
Bookmark.  The location (URL) will automatically be stored in your Bookmark 
list.  The next time you want to visit that site, click Bookmarks and then click the 
address you stored.

I found a URL in a magazine that I want to visit but I have no link to click on.
Click File | Open Location or press the Open button on the button bar, type in the 
URL, and click Open.  An easier way is to type the URL in the location box on the
menu bar and press Enter (Windows) or Return (Macintosh) on your keyboard. 

How can I find available information about any given subject on the Internet?
One option is to click the Net Search button to go to a page where you can search 
by word or phrase (a search engine).  A list of links to sites containing the word or 
phrase appears.  There are many different search tools using different search 
methods.  Therefore, different searches may return different results.
MindSpring offers a link to many search engines from the MindSpring home page 
at http://www.mindspring.com/.

Does the Find button do the same thing as a Search?
No!  The Find button only looks at the current page that you are viewing for 
whatever word(s) you enter.  A Search looks through thousands or even millions of
unseen Web pages of various databases for your word(s).

How can I develop my own Web page?
If you have one of MindSpring's service plans that provides Web space, you can 
create and store your Web pages on the MindSpring server.  The following table 
defines the high-level steps involved in creating a Web page:



Step Action

1 Design your page.

2 Add HTML tags.

3 Use the FTP Program to send it to your directory on 
MindSpring’s server.

4 Announce your page.  Check the Help section on our home 
page for instructions on writing, uploading and marketing your
own page.  There is also a link to a list of our subscribers' 
Web pages. 

Finding Help and Reference Information
Help is available while you are learning how to use Netscape Navigator.  

· Select Help topics, including The Handbook from the /  menus.
The Handbook provides comprehensive information to help get you started, to 
troubleshoot a problem, or to explore Netscape Navigator's knowledge about the 
Internet.  You can also try the MindSpring Help Desk at 
http://help.mindspring.com/.





Chapter 5

The Microsoft Internet Explorer Software

This chapter introduces Microsoft Internet Explorer, a popular web browser for navigating the World
Wide Web.  It covers:

· Launching Microsoft Internet Explorer

· Internet Explorer toolbar functions and menu options

· Frequently Asked Questions (FAQs) about Microsoft Internet Explorer
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Using Microsoft Internet Explorer (Windows only)
One of the hottest areas of the Internet is the World Wide Web.  To see the pages 
of the Web, you need a viewing tool called a web browser.  MindSpring provides a 
licensed version of Microsoft Internet Explorer for browsing the sites on the World 
Wide Web.
Use the following information only as a brief description of the many options, 
preferences, and capabilities of the Microsoft Internet Explorer.

Launching Microsoft Internet Explorer
To launch Microsoft Internet Explorer, click the Microsoft Internet Explorer icon 
on the PipeLine+ Access Panel.  You will enter the World Wide Web at the 
MindSpring web page, as shown in Figure 14.

Figure 15:  MindSpring web page 

Getting Started
From the MindSpring web page, choose any of the following suggestions to get 
started:
· Click on any blue underlined text, called a link, and you are transported to a 

Web page anywhere on the global Internet.  These links (originally called 
hyper-links) are the key to navigating the World Wide Web.

· Click the Links button, and you are introduced to several search engines where
you can look up any topic imaginable.  

· Click the Help button if you need help while learning how to use Microsoft 
Internet Explorer.  

· Click the Home button on the toolbar to return to MindSpring's home page.

Using The Toolbar Buttons
The following list explains the toolbar buttons that perform some of the most 
common tasks in the Microsoft Internet Explorer software.
Back – Displays the previous page in the history list.  A history list references a 
hierarchy of pages you've already viewed. 
Forward – Displays the next page in the history list.  Forward is available only 
after you use Back or a history item. 
Stop – Halts any ongoing transfer of page information. 
Refresh – Redisplays the current web page, reflecting any changes made prior to 
the original loading, if any change to the page has occurred. 



Home – Displays the start page designated in the View | Options | Navigation 
panel.  The default is the MindSpring home page location. 
Search – Loads a Microsoft Web page which displays multiple search engines.  
This button can be changed to display any search page.
Favorites – Adds the title of the current Microsoft Internet Explorer page to the list
of pages in the Favorites file.  Favorites, also called bookmarks, are stored as a list 
and represented by a file on your hard disk.  The Favorites list can be viewed in the
Favorites window.
Print – Prints the content area of the current web page you are viewing.  A dialog 
box lets you select printing characteristics. 
Font – Changes the font size on the web pages in the Internet Explorer window.  
Clicking this button cycles through larger or smaller font sizes. 

Using the Menu Options
The following list briefly describes each of the Microsoft Internet Explorer menu 
options.  This list is provided only as quick reference information.  For complete 
instructions on learning and using Microsoft Internet Explorer, refer to the online 
Microsoft Internet Explorer Help File.

The File Menu
New Window – Creates a new window with the same history items as
the previous window while bringing the current page to screen.
Open – Produces a dialog box that lets you enter the Internet address 
of a document or folder into the content area. 
Save – Lets you save selected text.  
Save As – Lets you to save the current page to a file on your 
computer.  This function saves only the text, not the graphics.
Send To – Lets you send the currently displayed URL to a disc, or to 
attach to an e-mail message, or to your “Briefcase” file. 
Page Setup – Lets you specify printing characteristics associated 
with the current page.
Print – Prints the content area of the current Microsoft Internet 
Explorer page.
Create Shortcut – Creates a shortcut to the current page and saves it 
to the Windows 95 desktop.
Properties – Displays the properties of the current page such as URL,
size, dates created, and security information.
Close – Closes this copy of Microsoft Internet Explorer.

 

The Edit Menu
Cut – Removes the current selection and places a copy on the 
clipboard. 
Copy – Places a copy of the current selection on the clipboard.
Paste – Puts the contents of the clipboard into the current page if 
possible, at the position of the selection marker.
Select All – Selects the entire document.
Find (on this page)... – Lets you specify a word or phrase to locate 
within the current Microsoft Internet Explorer page.  Press the Find 
button to begin the search.  If a match is found, the text is selected 
and scrolled to a visible position in the content area.  



The View Menu
Toolbar – Toggles the visibility of the toolbar buttons.  If checked, 
the toolbar buttons and Address/Links are visible.
Status Bar – Toggles the visibility of the Status Bar at the bottom of
the page.  If checked, the Status bar is visible.
Fonts – Lets you select font sizes displayed.  Check to display five 
font sizes ranging from smallest to largest.
Stop – Stops the connection in progress that is loading a page to the 
screen. 
Refresh – Brings a fresh copy of the current Microsoft Internet 
Explorer page from the Internet to replace the one originally loaded. 
The refreshed page displays changes made to the source page from 
the time of the original loading.
Source – Opens Windows 95 Notepad containing the current page 
in the HTML (HyperText Markup Language) format rather than the 
standard format.  The HTML format represents the source document
used to create the content and content style of a page.
Options... – Produces a multi-tabbed dialog box letting  you 
configure Microsoft Internet Explorer’s general appearance, network
connections, start page, programs, security, and advanced options.

The Go Menu
Back – Displays the previous page viewed. 
Forward – Displays the next page.  The Forward command is only 
offered after using Back command.
Start Page – Displays the home page whose location is specified in 
the View | Options | Navigation panel.  MindSpring's web page, 
http://www.mindspring.com/, is the default.
Search the Web – Loads a Microsoft Web page which displays 
multiple search engines.  This button can be changed to display any 
search page.
Today’s Links – Loads Microsoft’s daily page of new or interesting 
links.

The Favorites Menu
Add To Favorites – Adds the title of the current Microsoft Internet 
Explorer page to the list of pages in the Favorites file.  Favorites are 
stored as a list and represented by a bookmark file on your hard disk.
The Favorites list can be viewed in the Favorites window. 
Organize Favorites – Lets you move, rename delete, or open 
Favorite URLs.



The Help  Menu
Help Topics – Microsoft Internet Explorer Online Help contains a 
Contents Menu, an Index and the ability to search Help files for 
specific words.
Web Tutorial – A Microsoft Internet tutorial covering the basics 
through advanced topics.
Microsoft on the Web – Menu options for loading Microsoft web 
pages including Microsoft Product News, Online Support, Services, 
FAQs and Free Stuff.
About Internet Explorer – Version, copyright, and license 
information about the Microsoft Internet Explorer software.

Using the Right-Mouse Button Shortcuts
By clicking the right mouse button on a window, a pop-up menu appears with items
that are shortcuts for several commands. 
The items shown in the pop-up menu depend on the type of contents your mouse is 
pointing to on the window.  For example, when pressing the mouse button over a 
link, menu items refer to the page specified by the link; over an image, menu items 
refer to the image file specified by the image. 

Open – Displays the specified page in the current window.
Open In New Window – Displays the specified page into a 
newly opened window instead of the current window.
Save Target As... – Downloads and saves a copy of the 
specified page to a location of your choice without opening it.
Save Picture As... – Downloads and saves the specified picture 
to a location of your choice.
Set As Wallpaper – Saves the specified image as Windows 
Desktop wallpaper 
Copy – Copies the selection to the clipboard.
Copy Shortcut – Saves a copy of the location of the specified 
page to the desktop or to a folder.
Add to Favorites... – Saves the specified page to the Favorites 
list.
Properties... – Saves the specified image to disk (instead of 
displaying on screen). 
Save Background As – Downloads and saves the specified 
Background image to a location of your choice. 
Copy Background – Copies the specified background image to 
the clipboard.
Select All – Selects the entire document.
Create Shortcut –  Creates shortcut to the location of the 
specified page in a location of your choice, usually either on the 
desktop or in a folder.
View Source – Opens Windows 95 Notepad containing the 
current page in the HTML (HyperText Markup Language) 
format rather than the standard format.  The HTML format 
represents the source document used to create the content and 
content style of a page.
Refresh – Brings a fresh copy of the current Microsoft Internet 
Explorer page from the Internet to replace the one originally 
loaded.  The refreshed page displays changes made to the source
page from the time of the original loading.

FAQs about Microsoft Internet Explorer



Can I convert my Netscape bookmarks for use with Microsoft Internet Explorer?
Yes, in Microsoft Internet Explorer, you store and return to your favorite pages by 
using the Favorites menu instead of bookmarks. If you already have Netscape 
bookmarks defined, you can add them to your Favorites menu in Microsoft Internet
Explorer. 

How do I add my Netscape bookmarks to my Favorites menu? 
Follow these steps to add your Netscape bookmarks to your Internet Explorer 
Favorites menu:

Step Action

1 In Microsoft Internet Explorer , click the File menu, click 
Open, and then click Open File.

2 In the folder that contains your Netscape files (usually C:\
Netscape),  double-click the Bookmark.htm file.  Microsoft 
Internet Explorer opens the file.

3 On the Favorites menu, click Open Favorites.

4 Resize the Microsoft Internet Explorer  window until it fits 
side by side on your screen with the Favorites window.

5 Drag the bookmarks you want from the Microsoft Internet 
Explorer window to the Favorites window.

What is a URL?
A URL (Uniform Resource Locator) is an Internet "address".  Each Web page has a
unique URL.  Because URLs can often be long and difficult to remember or to 
type, the Copy, Paste, and Save As commands are commonly used when dealing 
with URLs.

What do the Back, Forward and Home buttons do?
Each time you start a Web session, Microsoft Internet Explorer keeps track of where
you've been.  Clicking Back and Forward moves you through the list of places 
you've been, one at a time.  Home returns to the MindSpring home page.  Note that 
once you've clicked a link, it changes from blue to purple to help you keep track of 
where you've been.  You can change the colors of links in the View | Options 
section.

Sometimes I click on a link and nothing happens . . . for a long time.
There are many reasons why this might happen.  The site you are trying to visit 
could be really busy or undergoing updating or repairs.  Occasionally, the Web 
seems to get hung up.  The best thing to do is to press Stop, then press the Reload 
button and see if you can connect.  If not, consider it a "no answer" and try again 
later.

Can I get Microsoft Internet Explorer to remember a place I like so I can visit it again later?
When you're viewing a site that you want to remember, click Favorites - Add to 
Favorites.  The location (URL) will automatically be stored in your Favorites list.  
The next time you want to visit that site, click Favorites and then click the address 
you stored.

I found a URL in a magazine that I want to visit but I have no link to click on.
Click File | Open, type in the URL, and click OK.  An easier way is to type the 
URL in the location box on the menu bar and press Enter  on your keyboard. 

How can I find available information about any given subject on the Internet?
One option is to click the Search button to go to a page where you can search by 
word or phrase (a search engine). There are many different search tools using 
different search methods.  Therefore, different searches may return different 
results.



MindSpring offers a link to many search engines from the MindSpring home page 
at http://www.mindspring.com/.
See additional Microsoft FAQs by clicking Help | Microsoft on the Web | 
Frequently Asked Questions.

Finding Help and Reference Information
Help is available while you are learning how to use Microsoft Internet Explorer.  
Click the Help button to find topics of inquiry while you are using the Microsoft 
Internet Explorer program.



Chapter 6
The Eudora Light Software

This chapter introduces Eudora Light, a powerful electronic mail (e-mail) program.  It 
covers:

· Launching Eudora Light

· A basic guide to sending and receiving mail with Eudora Light

· Frequently Asked Questions (FAQs) about Eudora Light

· How to find Help
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Using Eudora Light (for Windows)
Eudora Light is an e-mail program which is used to send messages to any person or
organization anywhere in the world that is connected to the Internet and has e-mail 
capability.  Files containing text, graphics and other information can be attached 
and sent with most messages.

Launching Eudora Light (Windows)

Follow these steps to launch Eudora:

Step Action

1 Click the Mail button on the PipeLine+ Access Panel to open 
Eudora Light.  The Enter Password window appears.

2 Type your password and click OK.  A progress window 
appears while Eudora logs on to the MindSpring mail server.  
Note:  Remember, the Eudora password is case-sensitive.   If 
you have trouble entering your password, verify that the Caps 
Lock key is off.

3 One of the following alerts appears:

· If there is no new mail, a "No New Mail" alert is displayed; click 
OK.

· If you have new mail, Eudora transfers the messages, one by one, 
and then displays a "You have new mail" alert.  Click OK.  New 
messages are delivered to your In mailbox. The In mailbox opens 
automatically and your new message summaries are added to the 
end of the mailbox list.  New messages are denoted by a bullet (l)
in the far left column of the message summary.  

4 Double-click a message summary to open the message.



Getting Started
The following sections explain how to do the basic e-mail activities, such as:
· Sending a message
· Attaching a file to a message
· Replying to a message

Sending a New Message (Windows)
Follow these steps to send a new message:

Step Action

1 From the Message menu, select New Message.  A message 
window appears with the blinking cursor in the To: field.

Note:  Your MindSpring e-mail  address (as shown in the 
above example,  user@mindspring.com ) appears in the From: 
field and cannot be altered.  

2 In the To: field, type the recipient's e-mail address.  (If you 
are sending the message to more than one person, separate 
their addresses with commas.)

3 Press the Tab key or point and click the mouse to move the 
cursor down to the Subject field.  Type some descriptive text 
indicating what the message is about.  
You may also enter an email address in the carbon copy field 
(Cc: ), enter an email address in the blind carbon copy field 
(Bcc: ), or add an attachment (see Attaching a File to a 
Message (Windows) ,  on page 77).

Step Action

4 Move the cursor to the large area below the Attachments: field
called the body, and type the message.

5 When the message is complete,  click Send.
The Eudora progress window indicates that the message is 
being mailed.

Note:  You can read and compose e-mail messages and replies offline.  You only 
need to be online to receive and send.



Attaching a File to a Message (Windows)
Attaching a file to a message sends a copy of that file with the message.  
Follow these steps to attach a file to an outgoing message:

Step Action

1 Prepare a message (a new message, a reply to a message, etc.).

2 From the Message menu, select Attach File.
A standard file window appears from which you can locate the
file you want to attach.

3 Find and select the file you want to attach, and click OK.  The 
file is listed in the Attachments: field of the message.  You 
can add as many files as you want using the same process.  To
delete an attachment,  click on the attachment once to select it,
and then press the Delete key on the keyboard.

4 When the message and its attachments are complete,  click 
Send.
The Eudora progress window indicates that the message and 
attachments are being mailed.

Note:  You may have trouble sending attachments cross-platform (Mac to Windows
or Windows to Mac).  An alternative to sending attachments is to upload the files 
to your FTP site (according to the disk space usage available with your MindSpring
service plan) from which the recipient can download the files.

Replying to a Message (Windows)
Follow these steps to reply to a message:

Step Action

1 Open the message for which you want to send a reply.

2 Select Reply from the Message menu.
The sender's message appears with the sender's address in the 
To field of the header.   The sender's original message text is 
preceded by ">" at the beginning of each line.  You may edit 
any part of the sender's original message.

3 Type your reply message.

4 When the reply is complete,  click Send.
The Eudora progress window indicates that the message is 
being mailed.

Using the Main Window Toolbar (Windows)
The main window toolbar consists of buttons you use as shortcuts:

Figure 16:  Eudora Light toolbar

The following table describes the buttons on the main window toolbar:

Button Description



Trash – Transfers and stores the current message(s) in the 
Trash mailbox.  All messages in the Trash mailbox are stored
there until emptied by the user.  Its function is identical to 
the Delete command under the Message menu.  
In mailbox – Opens the In mailbox. Its function is identical 
to the In command under the Mailbox menu.

Out mailbox – Opens the Out mailbox. Its function is 
identical to the Out command under the Mailbox menu.

Check Mail – Checks the server for, and downloads, new 
mail. Its function is identical to the Check Mail command 
under the File menu.
New Message –  Opens an outgoing message composition 
window.  Its function is identical to the New Message 
command under the Message menu.
Reply – Generates a reply to the current message or message 
summaries.  Its function is identical to the Reply command 
under the Message menu.
Reply All– Generates a reply to all recipients of the current 
message or message summaries.  Its function is identical to 
the Reply to All command under the Message menu.
Forward – Generates a forward message for the current 
message or message summaries.  Its function is identical to 
the Forward command under the Message menu.
Redirect – Generates a redirect message for the current 
message or message summaries.  Its function is identical to 
the Redirect command under the Message menu.
Previous Message – Closes the current message, and opens 
the previous message of the current mailbox.

Next Message – Closes the current message, and opens the 
next message of the current mailbox. 

Attach File – Presents a dialog box to locate a file to be 
attached to the current email message. Its function is 
identical to the Attach File command under the Message 
menu.
Address Book – Displays the Nicknames window.  Its 
function is identical to the Address Book command under 
the Tools menu.
Print – Prints a current message or signature file.  Its 
function is identical to the Print... command under the File 
menu. Its function is identical to the Nicknames command 
under the Window menu.
Context Sensitive Help – Changes the cursor to a question 
mark which will display Help information for an item on 
which you click. Its function is identical to the Context 
Sensitive Help command under the Help menu.

Note:  To learn about Nicknames and Signature Files, refer to Eudora's online 
Help.



FAQs about Eudora (Windows)

I'm getting the message "There has been an error transferring your mail. I said: PASS <shhh! 
Don't tell anyone>..." What's wrong?

The password you entered does not match what the mail server is expecting.  The 
mail server is a UNIX machine, and is by nature very finicky.  Be careful, it must 
be in all lower case.  Is your Caps Lock key on? 

I sent an e-mail message and it was returned.  Why?
Most likely, it was not addressed correctly. 
Verify the address.  Also, read the bounce message that came back with your mail. 
If it read "user unknown", the mail reached the other server, but the username was 
incorrect. If the return message said "host unknown", the domain (everything after 
the @ sign in the e-mail address -  mindspring.com, for instance) to which you 
were sending the message might be entered incorrectly. 

If I know the name of the document I want to attach, can I type it in the Attachments field?
No.  You can use the Attach File option from the Message.  You cannot edit the 
Attachments field in any way.

Can I send e-mail and attach files to my buddy on AOL/CompuServe/Prodigy?
Yes.  Type the address the usual way:  username@aol.com.  Attach documents 
using the Attach Document option from the Message menu or by dragging and 
dropping the file onto the message. 
The format for sending mail to users of other online services follows:
· America On Line: username@aol.com
· Prodigy: emailID@prodigy.com
· CompuServe: user.number@compuserve.com

Note: When sending mail from the Internet to CompuServe, change the comma in 
the mail ID to a period.  So user 71234,5678 is 71234.5678 from the Internet.

I attached a file to my e-mail and it came out as garbage on the receiving end. Why?
It was probably MIME encoded, and the receiver doesn't support that method of 
encoding.  You can turn MIME encoding off using the Encoding Method section 
under Tools | Options | Attachments.  Refer to the Eudora Light Online Help for
information about MIME.



My friend sent me a file via e-mail and it's been split into 7 different parts, all garbage.  What do I 
do with it now?

They are encoded.  Highlight all 7 parts, and save them (choose any name) with 
a .uue extension (i.e. filename.uue).  Then, run Wincode to decode them.  For 
information about Wincode, refer to Using Wincode on page 104.

Can I read mail offline?
Yes, if you haven't closed Eudora.  If you want to reply to messages and "hold" 
your out-going mail, you must uncheck the Immediate Send option.  To uncheck 
the Immediate Send option, choose Tools | Options | Sending Mail and then 
uncheck the Immediate Send option.  That way, you'll queue your mail for later 
delivery.  When you're ready, reconnect to MindSpring and choose File | Send 
Queued Messages.

How do I open Eudora offline?
When you start Eudora and you are prompted for a password, don’t enter the 
password, instead press Cancel.

How can I check mail from both home and work?
In the Checking Mail section of Tools | Options, check the box for Leave Mail on 
Server.  That way, a copy of your mail is kept on the MindSpring server even after 
you download it.   However, do not check Leave Mail on Server from both home 
and work.  Be sure that downloading from one location removes your mail from the
server.

Finding Help and Reference Information (Windows)
Eudora Light has Help files included within the program.  Choose Help from the 
Eudora Light menu bar and then select Topics.  Next, select Contents, Index or 
Find as needed.
Also, you can download Eudora's user guide for free from the following Web site 
(type this URL into Netscape Navigator’s Location field):
http://www.eudora.com/light.html
For a full listing of Qualcomm’s products and services, start with:
http://www.qualcomm.com/



Using Eudora Light (for Macintosh)
Eudora Light is an e-mail program which is used to send messages to almost any 
person or organization anywhere in the world that is connected to the Internet and 
has e-mail capability.  Files containing text, graphics and other information can be 
attached and sent with most messages.

Launching Eudora Light (Macintosh)

Follow these steps to launch Eudora on a Macintosh:

Step Action

1 Click on the Eudora icon on the Launch It! Toolbar to open 
Eudora Light.  A progress window appears while Eudora logs 
on to the MindSpring mail server.

2 If you have new mail,  Eudora highlights it in your In box, and 
signals you with a tone.  

3 Double-click on a highlighted message to open it.

Getting Started
The following sections explain how to do the basic e-mail activities, such as:
· Sending a message
· Attaching a file to a message
· Replying to a message



Sending a New Message (Macintosh)
Follow these steps to send a new message:

Step Action

1 From the Message menu, select New Message.  A message 
window appears with the blinking cursor in the To: field.

Note:  Your MindSpring e-mail address appears (as shown in 
the above example,  user@mindspring.com ) in the From: field 
and cannot be altered.

2 In the To: field, type the recipient's e-mail address.  (If you 
are sending the message to more than one person, separate 
their addresses with commas.)

3 Press the Tab key or point and click the mouse to move the 
cursor down to the Subject field.  Type some descriptive text 
indicating what the message is about.  
You may also enter an email address in the carbon copy field 
(Cc: ), enter an email address in the blind carbon copy field 
(Bcc: ), and add an attachment (see Attaching a File to a 
Message (Macintosh), on page 82).

4 Move the text cursor to the large area below the Attachments 
field, and type the message.

5 When the message is complete,  click Send.  The Eudora 
progress window indicates that the message is being mailed.

Note:  You can read and compose e-mail messages and replies offline.  You only 
need to be online to receive and send.

Attaching a File to a Message (Macintosh)
Attaching a file to a message sends a copy of that file with the message.  
Follow these steps to attach a file to an outgoing message:

Step Action

1 Prepare a message (a new message, a reply to a message, etc.).

2 From the Message menu, select Attach Document.
A standard file window appears from which you can locate the
file you want to attach.

3 Find and select the file you want to attach, and click OK.  The 
file is listed in the Attachments: field of the message.  You 
can add as many files as you want using the same process.  To



Step Action

delete an attachment,  click on the attachment once to select it,
and then press the Delete key on the keyboard.

4 When the message and its attachments are complete,  click 
Send.
The Eudora progress window indicates that the message and 
attachments are being mailed.

Note:  You may have trouble sending attachments cross-platform (Mac to Windows
or Windows to Mac).  An alternative to sending attachments is to upload the files 
to your FTP site (according to the disk space usage available with your MindSpring
service plan) from which the recipient can download the files.



Replying to a Message (Macintosh)
Follow these steps to reply to a message:

Step Action

1 Open the message for which you want to send a reply.

2 Select Reply from the Message menu.
Your reply message appears with the sender's address in the 
To field of the header.   The sender's original message text is 
preceded by ">" at the beginning of each line.  You may edit 
any part of the sender's original message.

3 Type your reply message.

4 When the reply is complete,  click Send.
The Eudora progress window indicates that the message is 
being mailed.

FAQs about Eudora (Macintosh)
I'm getting the message "There has been an error transferring your mail. I said:  PASS… and the 
POP server said:  -ERR Bad password or unknown username." What's wrong?

The password or username you entered does not match what the mail server is 
expecting.  The mail server is a UNIX machine, and is by nature very finicky.  Be 
careful, it must be in all lower case.  Is your Caps Lock key on? 

I sent an e-mail message and it was returned.  Why?
Most likely, it was not addressed correctly. 
Verify the address.  Also, read the bounce message that came back with your mail. 
If it read "user unknown", the mail reached the other server, but the username was 
incorrect. If the return message said "host unknown", the domain (everything after 
the @ sign in the e-mail address -  mindspring.com, for instance)  to which you 
were sending the message might be entered incorrectly. 

If I know the name of the document I want to attach, can I type it in the Attachments field?
No.  You must use the Attach Document option from the Message menu.  You 
cannot edit the Attachments: field in any way.



Can I send e-mail and attach files to my buddy on AOL/CompuServe/Prodigy?
Yes.  Type the address the usual way:  username@aol.com.  Attach documents 
using the Attach Document option from the Message menu. 
The format for sending mail to users of other online services follows:
· America On Line: username@aol.com
· Prodigy: emailID@prodigy.com
· CompuServe: user.number@compuserve.com

Note: When sending mail from the Internet to CompuServe, change the comma in 
the mail ID to a period.  So user 71234,5678 is 71234.5678 from the Internet.

I attached a file to my e-mail and it came out as garbage on the receiving end. Why?
It was probably encoded, and the receiver doesn't support the method of encoding.  
Three methods of encoding are available:  AppleDouble, AppleSingle, and BinHex.
You can select an encoding method from either the Message window or in Settings.
Refer to the Eudora Light Online Help for additional information about MIME.

My friend sent me a file via e-mail and it's been split into 7 different parts, all garbage.  What do I 
do with it now?

They are encoded.  Use UULite to decode the file.  If you don't have UULite, you 
can download it from the following Web site (type this URL into Netscape 
Navigator's Location field):
http://wwwhost.ots.utexas.edu/mac/pub-mac-compression.html  

Can I read mail offline?
Yes, if you haven't closed Eudora.  If you want to reply to messages and "hold" 
your out-going mail, you must uncheck the Immediate Send option.  To uncheck 
the Immediate Send option, choose Special | Settings… | Sending Mail and then 
uncheck the Immediate Send option.  That way, you'll queue your mail for later 
delivery.  When you're ready, reconnect to MindSpring and choose File | Send 
Queued Messages.  If you want to open Eudora without going online, press 
Cancel when Eudora prompts you for a password.

How can I check mail from both home and work?
In the Checking Mail section of Special | Settings, check the box for Leave Mail 
on Server.  That way, a copy of your mail is kept on the MindSpring server even 
after you download it.  However, do not check Leave Mail on Server from both 
home and work.  Be sure that downloading from one location removes your mail 
from the server.



Finding Help and Reference Information (Macintosh)
Eudora Light has extensive balloon help.  You can turn it on long enough to answer
your question, then turn it off again.  You can also select help topics from the /

 menu.
Also, you can download Eudora's user guide for free from the following Web site 
(type this URL into Netscape Navigator’s Location field):
http://www.eudora.com/light.html
You will need to download both the manual and the Acrobat Reader freeware (the 
manual is in Adobe Acrobat format).  
You can download a question and answer HyperCard stack called Eudora_QA.hqx 
from the following FTP site (type this URL into Netscape’s Location field):
ftp://ftp.eudora.com/Eudora/mac/documentation/ 
For a full listing of Qualcomm’s products and services, start with:
http://www.qualcomm.com/



Chapter 7
Windows Internet Applications

This chapter introduces the collection of Windows Internet software applications included 
with your PipeLine+ software package.  For each application, the chapter covers:

· A brief description of the application

· How to launch the application

· How to do the basic activities

· How to find Help

Chapter Table of Contents
This chapter includes the following sections:
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Using mIRC 98
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Using Free Agent
Free Agent is a powerful and easy-to-use Usenet newsgroup reader.  It allows you 
to browse newsgroups both online and offline.

Launching Free Agent 

Click the Agent icon on the PipeLine+ Access Panel to start Free Agent and the 
Free Agent main screen appears.

Getting Started
The following sections explain how to do the basic newsgroup activities, such as:
· Setting online preferences
· Subscribing to newsgroups
· Retrieving articles
· Decoding binaries
· Posting to newsgroups

Setting Preferences and Subscribing To Newsgroups
Follow these steps to set your preferences and newsgroups:

Step Action

1 Setting your online preferences.

· First, choose Preferences from the Options menu.
· Next, select the Online Operation tab.  
· Then, choose one of the following:

· The Use Online Defaults button if you wish to stay online 
while using Agent.

· The Use Offline Defaults button if you wish to minimize 
your time online. 



Step Action

2 Getting a list of groups.

To retrieve the list of groups, select Refresh Group List from 
the Online menu.  Once the groups are retrieved, Agent will 
display them in the Group Pane (See Free Agent Help).

Note:  There are currently over 20,000 newsgroups.  The 
refresh operation will take several minutes.

3 Subscribing to groups.

· Choose Find from the Edit menu to find a particular group.
· Scan the list of groups for ones you want to follow regularly.
· When you find a group that may be of interest, double-click on it.
· If you want to get a feel for the group before subscribing, press the

Sample 50 Article Headers button.
· If you know you’re interested in the group, press the Subscribe to

Group button.

4 View only subscribed groups.

· From the Group menu, choose Show Only Subscribed Groups.  
Now your group pane is filtered to show only the groups you’re 
interested in.  

· To view all groups again, select Show All Groups from the Group
menu.

Retrieving Articles
Follow these steps to retrieve articles:

Step Action

1 Retrieve article headers in your subscribed groups.

Choose Get New Headers in Subscribed Groups from the Online 
menu to download all the article headers in all your 
subscribed groups.

2 Browse the article headers.

Once the article headers are retrieved, browse them to see 
which ones interest you.

Step Action

3 Retrieve marked articles.

If you’re using the offline defaults, you marked several 
articles when you subscribed to groups previously.  

To retrieve the full text of all marked articles, select Get 
Marked Article Bodies from the Online menu.  See How to Use 
Agent as an Offline Newsreader  in the Free Agent Help for 
more information.

Posting To Newsgroups
Follow these steps to post to newsgroups:



Step Action

1 Select the group to which you wish to post.

A group is selected when it is highlighted in the Group pane or
when you are viewing articles for it in the Article pane.

2 Select the article to which you are responding (optional 
step).  

If your article is a follow up to another posting, select that 
article first so that your posting is properly formatted.

3 Open a new Posting window.

· From the Post menu, choose New Article or Follow Up Article, 
depending on the type of posting you want.

· Fill in the Posting window’s fields.

4 Send the article.

· If you use Agent online, press Send Now to immediately transmit 
your message to the Internet.  

· If you use Agent offline and you have other messages you want to 
send, press Send Later.  Once you have composed all your 
messages, select Post Articles and Emails from the Online menu 
to transmit them to the Internet.

Note:  Please review Statement of Policy in Chapter 1 – MindSpring Services 
regarding inappropriate activities.



Decoding Binaries
Free Agent takes the sometimes mystical art of decoding binaries from the 
newsgroups, and simplifies the process.  Follow these steps to decode a binary:

Step Action

1 To decode a binary, simply highlight it as you would any other 
message, then press the Camera button located on the menu bar.  Free
Agent automatically decodes all UUEncoded binaries, the most 
common coding format, and place them in a download directory.  

2 If the binary is a graphic in one of the common graphics formats, Free
Agent automatically launches LView Pro, a graphics viewer, and 
displays it for you.  For information about LView Pro, turn to 
page 102.

3 If the binary is an archived file, Free Agent automatically launches 
WinZip and allows you to extract the parts from it.  For information 
about WinZip, turn to page 106.

Finding Help and Reference Information
Free Agent has Help files included in the program.  Choose Help from the Free 
Agent menu bar and then select Topics.  Next, select Contents, Index or Find as 
needed.



Using WS_FTP
The WS_FTP file transfer program may be used to transfer files to or from many 
remote computers that are connected to the Internet.  Files containing text, graphics
or computer programs can be transferred.

Launching WS_FTP

Follow these steps to launch WS_FTP:

Step Action

1 Click the FTP button on the PipeLine+ Access Panel to 
open WS_FTP.  The Session Profile window appears with 
MindSpring FTP in the Profile Name  field, as shown in 
the following sample screen:

2 Select Anonymous Login.  The Password field is 
automatically filled in with your e-mail address.

3 Click OK.  The WS_FTP Main screen appears.

Getting Started
WS_FTP has many options, buttons, and configurable parameters.  This section 
introduces only the basic functions.  For a complete explanation, see the extensive 
Help files located on the WS_FTP menu bar.
The following sections explain how to do these basic FTP activities:
· Connecting to a remote site including MindSpring
· Downloading a file from MindSpring’s server
· Uploading a file to your ftp or www directory on the MindSpring server
· Creating an incoming FTP directory
· Changing the name of a remote file

Connecting to MindSpring’s FTP Site
Follow these steps to connect to MindSpring’s FTP site:

Step Action

1 Click the Connect button.  The FTP connection is 
initiated.



Step Action

Note:  Local directories (your system directories and files)
always appear on the left side of the screen.  After you 
establish a connection, the remote directories and files are
on the right.



Downloading a File
Follow these steps to download a publicly accessible file from the MindSpring 
server:

Step Action

1 After connecting via Anonymous Login, do the following:

· Double-click the remote directory pub and then software.  

· Next, select either windows (Windows 3.1 or 3.11 users) or 
win95 (Windows 95 users).  

· Select a software file you wish to download in the lower field 
of the Remote System.  (Double clicking on the two dots 
takes you back up one directory level.)

Note:  To connect and download files from your own user 
directories, you must enter your username and password in
the proper fields, and de-select Anonymous Login.

2 Select a local directory (on your system) to which you 
wish to download the remote software file.

Step Action

3 Click the ¬ button which points from the remote system to
the local system.  The file begins to transfer.

Uploading a File
You can upload files to your own MindSpring user directories.  Your user 
directories are displayed when you connect using your username and password.
Follow these steps to upload a file:

Step Action

1 From the session profile window with MindSpring FTP in the 
Profile Name field , enter your user name and password in the 



Step Action

appropriate fields.  

Note:  Web pages should go in your www directory.

2 De-select the Anonymous Login box.  Click OK.

3 Select your desired user directory (www, ftp, etc.) in the 
Remote System field,  to which you want to upload a file.

4 Select the desired file you want to upload.

5 Click the ® button which points from your local system to the 
remote system.  The file begins to transfer.  Rename the file,  
if necessary.

Creating an Incoming FTP Directory
If you want to allow others to upload file to your FTP space, you must create 
an incoming directory and set the permissions for the directory.  Follow these 
steps to create an incoming FTP file:

Step Action

1 Connect to your user directory on the MindSpring server.

2 Select the MkDir (Make Directory) button to create a directory.
Name the directory "incoming" (without the quotes).



Step Action

3 To set the permissions for the directory, do the following:

· Click the right-mouse button inside the remote directory window.
· Choose FTP Commands.
· Then choose Site.
· Type the following:  SITE chmod 1777 incoming

4 Close your FTP client.

5 Test the directory by doing the following:

· Log back in to ftp.mindspring.com as an anonymous user.
· Go to your ftp space.
· Go into your incoming directory.
· Try uploading a test file to be sure it works.

Note:  Anyone can upload files anonymously to the incoming directory, but cannot 
delete or overwrite files.  Likewise, anyone can download files from this directory.

Renaming a Remote File
Follow these steps to rename a remote file:

Step Action

1 Connect to your user directory on the MindSpring server.

2 Select the file whose name you want to change.

3 Click the Rename button.

4 Enter the new name.  Click OK.



Tips and Techniques
These basic techniques can be used for any FTP site.  
· Open the Profile Name menu on the Session Profile screen to see the many 

FTP sites included with WS_FTP.
· MindSpring puts new software releases on our server for you to download via 

FTP.  To access these, log in as User ID guest and password set to 
yigreyg9. 

· To save a Session profile, click the Save button just below the Profile Name 
field on the Session Profile screen.  To save your password with the 
session profile, select the Save Password checkbox.

Finding Help and Reference Information
WS_FTP has Help files included in the program.  Choose Help from the WS_FTP 
menu bar and then select Topics.  Next, select Contents, Index or Find as needed.



Using mIRC
mIRC is a Windows client for the Internet Relay Chat (IRC) network.  It allows 
Internet users to chat electronically with each other in a group or channel using 
IRC servers. 

Notice:  mIRC is shareware and may be freely distributed for evaluation purposes.  
If you decide to keep and use the program, you must send payment directly to the 
shareware author.

Launching and Configuring mIRC
Follow these steps to launch and configure mIRC

Step Action

1 Click the IRC icon on the PipeLine + Access Panel to execute mIRC. 
A shareware notice will appear.  After you’ve read the information 
presented in the window, close the window to continue..  

2 At the mIRC Setup  window, the IRC Servers  tab should already 
be selected.

Select MindSpring’s IRC Server  from the list of servers.
Or, you can select a different server from the list.

Enter your user information:

· Real Name:  Type your full name.

· E-Mail:  Type your email address.

· Nickname:  This is the name people will know you by in IRC.  
IRC servers allow only one person at a time to use a 
particular nickname.

· Alternate:   Type another nickname you’d like to be known by 
in case your first choice is taken.

· 3 When you’ve filled out the required fields, click Connect! to 
connect to the IRC server you have chosen.



Getting Started
The following sections explain how to use IRC as well as how to:
· Connect to an IRC server
· Join a chat channel

Connecting to an IRC Server and Joining an IRC Channel
Follow these steps to connect to an IRC and join an IRC channel

Step Action

1 Choose Connect from the File  menu.  The message of the day 
appears.

2 A window titled mIRC Channels Folder will appear.  This window 
contains a list of various IRC channels.  This window only contains a 
few sample IRC channels to pick from. You may select a channel 
from this list and click Join, or click OK to go back to the Status 
window to list all channels on the server.

If you’ve opted to return to the Status window, then do one of the 
following:

· Type /list in the Status  window entry box to see all the 
channels that your server sees.  This may take a while.  A list
of channels appears.  Double-click any channel of interest.

· Type /join #chat to join the #chat channel.  Channels on 
IRC always begin with the ‘#’ character.

· 3 Once in the channel, type anything you want.  It is common courtesy 
to simply type Hello all to see if anyone is there and friendly.  
You can also join another channel or create your own.  To leave a 
channel, type /leave or /part or close the channel’s window.

4 Once you find a channel you like to visit, you can join it by either 
double-clicking the channel listing in the window, or type /join 
and the channel name.  All IRC channels start with the character #, 
and you must include this as part of its name. 

You can try #mindspring and see if anyone is there.  

IRC Server Connectivity
The following is a list of some IRC servers you can connect to using mIRC:
· irc.mindspring.com
· irc.colorado.edu
· irc.law.emory.edu
· mickey.cc.utexas.edu
· minnie.cc.utexas.edu
· tramp.cc.utexas.edu
· irc-2.mit.edu
· irc.cerf.net
· irc.sdsc.edu
· irc.ucsd.edu

IRC Tips
Just as in the newsgroups, IRC has developed its own way of doing things.  Our 
best advice to you is to simply join a few channels and see how people do things.  



You can’t hurt anything by watching.  If you don’t understand a command, try the 
help file in mIRC.  If you still don’t understand something, ask politely.
Unlike the online services, in IRC you can be involved in multiple rooms at the 
same times.  If one channel seems to be lacking in conversation, you can join 
another channel while monitoring the previous channel.
IRC also allows private conversations, and the exchange of files directly between 
two users.  There are also automated responders called bots in many channels.

Finding Help and Reference Information
mIRC has help files included in the program.  Choose Contents from the Help 
menu in mIRC.  Help is also available at the MindSpring Help Desk at 
http://help.mindspring.com



Using EWAN / Telnet
MindSpring provides EWAN Terminal Emulator, a Telnet client from Peter 
Zander. Telnet is a tool used to log on to other systems on the Internet.  Once 
you're there, Telnet lets you use the system as though you were sitting at its 
keyboard. 
You cannot use Telnet to log on to the MindSpring server.  That requires a shell 
account, and MindSpring offers only PPP Dial-Up accounts.  You can use Telnet to
get from MindSpring to other computers.  Usually, you need an account on the 
remote system, login instructions, and the commands necessary to navigate the 
system.  Some systems are available to the public without an account.  In our 
example below, you'll log onto The University of California, San Diego bookstore 
to check on the New York Times bestseller list.

Launching and Logging on with Telnet

Follow the steps in this example to launch EWAN/Telnet, connect to a site, and log 
on with Telnet:

Step Action

1 To launch Telnet, click the Telnet icon from the PipeLine+ Access 
Panel.  The Telnet window appears.

2 Click the New button to enter a new site

3 Enter the site name in the Name field, for example, "San Diego 
bookstore". 

4 Enter the Telnet address in the Network Address or Host Name field.  
The address is added.

5 Now, highlight the entry and click OK to connect (or just double-click
the address).  MindSpring connects you to the San Diego bookstore 
system.  The login prompt appears.

Finding Help and Reference Information
Telnet has Help files included in the program.  Choose Help from the Telnet menu 
bar and then select Topics.  Next, select Contents, Index or Find as needed.



Using LView Pro
LView Pro is a graphic viewer and manipulation program that allows you to alter 
image files for use in desktop publishing, presentations, or web page creation. 
LView software is Copyright Ó 19931996 by Leonardo Haddad Loureiro. LView 
may be contacted via the World Wide Web by going to http://www.lview.com. 
Please note that LView is a shareware product. Continuous use of it requires 
payment of registration fees.

Launching LView Pro

Windows 3.1 and 3.11 users – From the PipeLine+ group box in Program Manager, 
click the LView Pro icon to launch application.
Windows 95 users – Click the Start button, next select PipeLine+, and then click 
LViewPro to launch the application.

Getting Started
The following sections explain the basic LView Pro activities, such as:
· Opening Image files
· Altering Image files
· Getting Help

Opening an Image File
Follow these steps to open an image file:

Step Action

1 Click File | Open.  A window displays "List Files of Type" and 
shows a default file type.

2 Click the down arrow to the right of the window to display the 
full list of file types.

3 Highlight the file type you want to display.

4 Move to the directory containing the file you want to view, and 
then highlight the file.  Click OK.  The file appears.



Altering Image Files
Any file can be altered with LView Pro.  Follow these steps to change a 
graphic:

Step Action

1 Use the Edit menu to see various choices for resizing, re-
orienting, and adding text to images.

2 Use the Retouch menu to see tools for altering color 
correction, color depth, background color (used in creating 
transparent .gif images) as well as filters for sharpening 
images, finding edges, and converting to negative and 
grayscale.

Finding Help and Reference Information
Click HELP on the LView Pro menu bar to view the LView Pro online help.



Using Wincode
Wincode is a freeware program written by G.H. Silva used for encoding/decoding 
binary file formats, such as uuencode. 

Launching Wincode

Windows 3.1 and 3.11 users – Click the Wincode icon on the PipeLine+ Access 
Panel to launch the application.
Windows 95 users – Click the Start button, next select PipeLine+, and then click 
Wincode to launch the application.

Getting Started
The following sections explain the basic encoding/decoding activities, such as:
· How to decode files
· How to encode files

Using Wincode to Decode Files
Single or multiple files can be encoded or decoded with Wincode.  Follow these 
steps to learn the basics of Wincode:

Step Action

1 Select File / Decode from the Wincode menu.  A File to Decode 
dialog box appears.

2 Scroll through the Directories list to locate the file(s) you wish to 
decode.

3 Double-click the Dialog Title Bar to select a different decoding 
algorithm.  Wincode cycles through the possible Code Types 
available.

4 Select the file or type the filename in the entry box.  Select OK to 
begin decoding.



Using Wincode to Encode Files
Follow these steps to encode a file:

Step Action

1 Select File | Encode from the Wincode menu.  A File to Encode 
dialog box appears.

2 Select the Options button to re-check the settings Wincode uses to 
encode the file(s).

3 Locate the file(s) you want to encode.

4 Double-click the Dialog Title Bar to select an encoding algorithm.  
Wincode cycles through the possible Code Types available.

5 Select the file you want to encode.  Select OK to begin encoding.

FAQs about Wincode

When would I use Wincode?
You can encode a file to send as an encrypted e-mail message, or decode a message
that was sent to you. You can also use it to view binaries in newsgroups. 

How do I use it to view binaries from a newsgroup?
Save the .uue file or files.  Refer to Using Free Agent, on page 88, for instructions 
on how to download files.  From Wincode, click File-Decode and select the 
filename.  The file is decoded.  You can view it using LView Pro.

How do I use it to decode e-mail?
From Eudora, highlight the encoded files.  Click File | Save As and choose a 
filename.  Then, launch Wincode.  Click File | Decode, and enter the filename.  
Your file will be automatically decoded.

Finding Help and Reference Information
A file called helpme.txt is included with Wincode and can be accessed from 
Program Manager or Explorer.  Additional Help files may be acquired by e-mailing
a request to the program’s author, George H. Silva at 
wincode@snappy.globalone.net.



Using WinZip
WinZip is a utility that compresses and decompresses files.  This is useful for 
preparing large files for transport over the Internet, either via FTP or as an 
attachment to e-mail.

Notice:  WinZip is shareware and may be freely distributed for evaluation 
purposes.  If you decide to keep and use the program, you must send payment 
directly to the shareware author.

Launching and Using WinZip

Warning:  Be careful about where you extract files using WinZip.  WinZip, by 
default, extracts to the directory it extracted to last time.  When extracting / 
expanding new files, extract to an empty temporary directory.

Follow these steps to launch and use WinZip:

Step Action

1 Windows 3.1 and 3.11 users – From the PipeLine+ group box in 
Program Manager, click the WinZip icon to launch application.
Windows 95 users – Click the Start  button, next select 
PipeLine+ , and then click WinZip  to launch the application.  

2 Select a file to be opened or unzipped.

3 Click the Extract button.

4 Choose a location for the extracted files.  Click OK.

Tips and Techniques
· Double clicking on a file in the main WinZip window has the same effect as 

double clicking in the File Manager or Explorer.  First, the file is extracted
from the archive.  Then, if the file is executable, it is run.  Otherwise, the 
file is opened by the appropriate application (for example, Windows Write
for *.WRI files) based on standard Windows associations.

· The Windows Drag and Drop interface is fully supported.  You can drag and 
drop files from WinZip to other applications.  WinZip extracts the files 
before dropping them on the target application.  The target application 
treats the files as if they had been dropped by the File Manager or 
Explorer.  You can also drop archives on WinZip to open them, or drop 
files on WinZip to add them to the open archive.

Finding Help and Reference Information



WinZip has Help files included in the program.  Choose Help from the menu bar; 
then select Contents or Search as needed.





Chapter 8
Macintosh Internet Applications

This chapter introduces the collection of Macintosh software applications included with your 
PipeLine+ software package.  For each application, the chapter covers:

· A brief description of the application

· How to launch the application

· How to do the basic activities

· How to find Help

Chapter Table of Contents
This chapter includes the following sections:
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Using Anarchie 113
Using Homer 118
Using Fetch 123
Using StuffIt Expander 126
Using JPEGView 128
Using SoundMachine 130



Using NewsWatcher
Usenet newsgroups provide an unlimited supply of free information, opinion, 
discussion, and entertainment, and they can also be an excellent way to waste time!
You can find newsgroups covering just about any subject, where you can read 
articles, post your own questions, open a subject for debate, join in any discussion, 
and sound off on your own opinions.  Newsgroups provide a very personal way to 
interact with people from around the world, though it is unlikely that you’ll ever 
meet people you get to know through a newsgroup.  Each newsgroup has its own 
flavor, culture, and level of seriousness.  It may take a while to find your niche, but
a little searching can be very rewarding.
MindSpring provides a registered freeware version of NewsWatcher, a popular 
newsreader for the Macintosh.  

Launching NewsWatcher
From the PipeLine+ Access panel, connect to MindSpring, then click on the 
NewsWatcher button on the Launch It! Toolbar. 
Note:  There are currently over 20,000 newsgroups.  If you refresh the group list, it 
will take several minutes.  You can look in the NewsWatcher subdirectory in the 
PipeLine+ folder for the full group list.

Figure 17:  The NewsWatcher Full Group List window



Getting Started
From NewsWatcher, try these suggestions to get started:
· Pick an interesting sounding newsgroup and double-click on the name to 

download a list of articles. If a triangle and a number are next to the 
author’s name in the list, that means there are related articles in a thread, 
or series of responses.

· If you have trouble finding a group that sounds interesting, select Find from 
the Edit menu and type in a word or abbreviation to search the newsgroup 
list for.  For example, type nz or zeal to search for groups about New 
Zealand, astro for astronomy or astrology, travel for groups related to
travel, the name of your favorite topic, game, sport, TV show, or a 
program that you have questions about.  The possibilities are endless!

· Pick an interesting sounding article from your selected newsgroup, and double-
click on the name to read the article.  The header includes the author and 
the names of the newsgroups the article was posted to (if you like the 
article, you may want to check out the other newsgroups it was posted to).

· If you want to scroll from article to article, the header of each article has an up 
and a down arrow.  Just click to move from article to article.  For 
information about using keyboard shortcuts to scroll through a long article 
or from article to article, select Keypad Shortcuts or Main Keyboard 
Shortcuts from the /  menu.

· Articles that you have looked at will have a check mark by the name.  If you 
double-click on the article’s name, but the article doesn’t open, select 
Mark Unread from the News menu.  This will allow you to open articles 
that you looked at in a previous session.  Be careful about waiting until 
later to read an article, though.  It depends on how active a group is, but 
often articles will only stay posted for a day or two.

· If you know you want to read an article, but don’t want to read it at the 
moment, or don’t want to take up time while you are connected to 
MindSpring, you can save it to your hard drive and read it later.  Select 
Save As from the File menu.  If you select a group of articles, they will be
saved to the same file, one after the other (called appended).

· If there is a URL (Internet “address”, often a Web page) in the article, and you 
want to check it out, hold the Command key (the key with the apple and 
the four-parted symbol) and click on the URL.  This is just like a link in 
Netscape.  If it starts with http, Netscape launches and goes to the selected
Web page.  If it starts with ftp, Anarchie launches and goes to the selected
FTP site.  If nothing happens, be sure you are connected to MindSpring, or
check your preferences as follows:

- Select Preferences from the File menu, then select URL Helper 
Programs.  Click on ftp or http, then click on the Change button to 
select the program that should launch for a URL with that prefix.  
Also, be sure Use HTTP helper instead of FTP helper for “.html” 
files is selected.  Click on the OK button to save your changes.

Creating Your Own Group List (Subscribing)
Once you have found newsgroups that you want to read or post to regularly, you 
can subscribe to them.  All this means is that you add them to your personal group 
list for easy access.  Be sure to include some of the MindSpring newsgroups in your
list; they are a great source of information for the MindSpring user community.
Select New Group Window from the File menu, then just drag the names of the 
groups you want to subscribe to from the full group list into the untitled window.  
To save your personal group list, select Save from the File menu, name the file, 
and select the folder on your hard drive you want to save it in.  
To remove a newsgroup from your list (or unsubscribe), select it, click on the 
Delete key, then save your file again.  
If you want NewsWatcher to automatically check your subscribed newsgroups for 
new articles every time you launch, you can add your personal group list icon to 
the Launch It! toolbar.  Just drag your personal group icon from the Finder to the



 icon on the LaunchIt! toolbar (if you have drag and drop), or click on the plus 
sign to select your personal group list file in the file selection dialog box.  The next
time you launch NewsWatcher, click on your personal group icon instead of the 
NewsWatcher icon.  

Finding Help
NewsWatcher has online help topics available from the /  menu that describe 
most aspects of using NewsWatcher, plus it has extensive balloon help available.
For more information about newsgroups, check out any of the newsgroups starting 
with news.  For example, if you want to learn about creating a new newsgroup, go 
to news.answers.
To find additional information about NewsWatcher, or to keep up with the latest 
releases, check out Northwestern’s FTP site (type this URL into Anarchie or 
Netscape Navigator):
ftp://ftp.acns.nwu.edu/pub/newswatcher/



Using Anarchie
Most FTP (File Transfer Protocol) programs only transfer files to and from FTP 
sites on the Internet.  If you don’t know the exact name or location of a file, you 
have to go to a different program to search for it.  MindSpring provides a registered
shareware version of Anarchie, an FTP program for the Macintosh that can search 
for files as well as download and upload them.
With Anarchie (pronounced anarchy, not an archie), you have several options for 
finding and downloading files:
· If you know the name and location of a file, you can type or paste the 

information into a window and download the file with a single click.
· If you know the name (or partial name) of a file, but don’t know the location, 

you can search Archie servers for that file, or similar files, and download 
the ones you want just by double-clicking.  

· If you know the name of an FTP site, you can download a file listing to browse
through, and then download any file you want just by double-clicking.

· If you just want to browse around and see what you can find, and don’t know 
where to start, Anarchie includes an extensive list of bookmarks that you 
can browse through and download files from, just by double-clicking.

Launching Anarchie
From the PipeLine+ Access panel, connect to MindSpring, then click on the 
Anarchie icon on the Launch It! Toolbar.

Getting Started
The following sections explain how to:
· Set up Anarchie when you first launch it
· Find and download files using an Archie search
· Download files or file listings from specific FTP sites using the Get window
· Browse through a multitude of FTP sites in the Bookmarks window



Initial Setup
The first time you launch Anarchie, you will see a dialog box about using Internet 
Config to configure Anarchie.  You can use Anarchie without Internet Config, but 
if you want to select a folder for your downloads (the Desktop is the default), or 
change the display font in directory listing windows, you will have to use Internet 
Config.  The PipeLine+ package includes Internet Config 1.1.  
To bypass Internet Config, click on the I Don’t Care button.
To use Internet Config, follow these steps:
· Click on the Launch Internet Config button.  
· If you see a message box about installing the Internet Config extension, click 

on the Install button.  You will then see a message that the installation 
was successful.  Click on OK.  

· Internet Config launches.  You have a choice of eight buttons.  Each will 
display a different window, with lots of empty fields.  Don’t worry; there 
are only a few fields that you need.  For information about each field, turn 
balloon help on.

· To select a download folder, click on the File Transfer button.  There are three
fields for selecting default servers, which you can select if you want.  
Click on the button next to Download Folder.  Find and select the folder 
you want your downloads to be saved in, then close the File Transfer 
window.

· To change the display font in directory listing windows, click on the Fonts 
button.  Select the font and size you want under List Font, then close the 
Fonts window.

· Save your changes by selecting Save from the File menu, then quit Internet 
Config.

You can also launch Internet Config from within Anarchie.  Select Preferences 
from the Edit menu and click on Launch Internet Config.  
In the Preferences window, you can also select what windows to display when you 
launch Anarchie, and whether you want to automatically expand compressed or 
encoded files after downloading (Post Process).



Finding Files Using an Archie Search
If the Archie window doesn’t already display, select Archie from the File menu.

Figure 18:  The Archie search window

Click on the down arrow next to the Server field to see a list of Archie servers.   
Pull down to the bottom of the list and pick one in the United States.  It doesn’t 
matter which one you pick, but its better to pick one in your country.
Enter the name of the file you want to search for in the Find field.  You don’t have 
to enter the whole file name, but enter enough characters of the name to be 
specific.  In general, the fewer characters you enter, the more matches you will 
find, and the lower the chance that they will be the file you want.  The more 
characters you enter, the higher the chance that you’ll find your file, though if you 
enter too many characters, you may not get any matches at all.
Most of the time, you’ll want to leave Sub-string selected, Case Sensitive 
deselected, and the Matches number to 40.  
To search, click on the Find button.  A progress window displays during the search,
then a window displays each file cataloged on the server that matched the search, 
listing name, size, date, zone (how far from you the file is, geographically), 
machine, and path.  If the search didn’t find the file you want, try it again on a 
different Archie server, or with a different entry in the Find field.
You can sort the files in this window by clicking on any of the headings.  For 
example, if the file you want to download is listed several times, and you want to 
download from the closest source, click on Zone, then pick the first occurrence of 
the file in the list (1=closest; 5=farthest).  Or you may want to sort by Size.  A huge
file will take a long time to download, but beware of very small files, too.  If you 
are downloading a program, and you see two files of the same name, one is 533k 
and the other is 1k, chances are there is something wrong with the 1k file.  Or a 
small file could be a ReadMe file about the program.
When you know which file you want to download, double-click on it.  A progress 
window displays during the download, with useful information like how much 
longer it will take, so you know whether to wait expectantly by your computer or to
go rummage in the fridge.  You can also keep working while the file is 
downloading; it can download in the background while you perform other tasks on 
your computer.
If you want to download multiple files, Shift-click to select them all, then double-
click to download them one after another.

Note:  If you find a directory that you’d like to be able to return to easily, you can 
save it as a bookmark (see the Browsing Bookmarks section).

Downloading Files or File Listings using the Get Window
Select Get from the FTP menu.  The Get via FTP window displays.



Figure 19:  The Anarchie Get window

If you found a URL (Internet “address”) for an FTP site online (in a document or e-
mail, for example), you can copy it from the source and paste it into the Anarchie 
Get window.  Paste it into either the Machine or Path field.  Anarchie will sort it 
out for you and put the machine information in the Machine field, and the path and 
file information in the Path field.  
If you can’t paste your URL, and have to sort it out yourself, here’s how:
· Type the part between the double slash (“//”) and the first single slash (“/”) in 

the Machine field.
· Type the rest, leaving out the first slash, in the Path field.
· For example, ftp://ftp.orst.edu/pub/mirrors/archive.umich.edu/ would sort 

out:
- Machine: ftp.orst.edu
- Path: pub/mirrors/archive.umich.edu/

Note:  If you are looking for software to download, browse through the site in this 
example.  Any of the UMich or Info-Mac sites are great.  Anarchie supplies 
bookmarks to these sites.  For more information see the next section, Browsing 
Bookmarks.

If your URL is a directory, select Get Listing then click on the List button to 
download a list of files in that directory.  If your URL is a file, select Get File then 
click on the Get button.  If you would rather see a listing than get the file, delete 
the file name.  If you want to see related directories, delete the last one or two 
directory levels, then navigate through directories by double-clicking on folders to 
find the files you want.  If you don’t know whether your URL is a file or directory, 
pick either of the options.  You will see an error message if you picked the wrong 
one.
Downloading is the same as described in the Finding Files Using an Archie 
Search section, above (just double-click and the rest happens automatically).

Note:  If you find a directory that you’d like to be able to return to easily, you can 
save it as a bookmark.

Browsing Bookmarks
Select List Bookmarks from the File menu.  



Figure 20:  The Anarchie Bookmarks window

Anarchie’s list of bookmarks is seemingly endless.  Where to start?  If you want to 
download software, look through the list for the name of the program, the company
or person who makes it, or you can try one of the many Info-Mac or UMich sites.  
If you’re looking for pictures to download, try Pictures (Sweden) for shots of 
everything from Greece to Godzilla.  Navigate around by double-clicking on 
folders.  If you open a directory you aren’t interested in, close that window and go 
back to one of the other windows you already have open.
If you find a directory you’d like to be able to return to easily, select Save 
Bookmark from the File menu.  Be sure you save the file in the Bookmarks folder 
in the Anarchie-160 folder.  To return to a directory that you saved as a bookmark, 
select Open Bookmark or List Bookmarks from the File menu.
If you’d like to save a directory listing as a text file, as a reminder of the 
directory’s contents, select Save Listing from the File menu.
Downloading is the same as described in the Finding Files Using an Archie 
Search section, (just double-click and the rest happens automatically).

Finding Help
Anarchie has an online manual, that you will need Apple Guide to view.  If you 
have System 7.5, or the Apple Guide extension, select Anarchie Guide from the 
/  menu for complete documentation.
Anarchie also uses balloon help.  You can turn it on long enough to answer your 
questions, then turn it off again.  Also, look in the Anarchie-160 folder for a file 
called Documentation.  



Using Homer
This section introduces Homer, an IRC or Chat program for participating in real-
time discussions with people from all over the world.  
IRC stands for Internet Relay Chat, a service on the Internet that allows you to 
participate in real-time group discussions with anyone in the world who has access 
to IRC.  Conversations take place in channels, groups of people gathered to discuss
specific topics, or just groups of like-minded people who want to chat.  One 
warning, though, there are quite a few channels that use explicit language.  You 
can get a feel for that by looking through a list of channel names.
Channel subjects range as widely as the Internet, and because of the immediacy of 
IRC, it is a great place to follow major world events as they are happening.  To find
more information, sample lists of channels, as well as logs of chat sessions that 
took place during such events as the Oklahoma City bombing, use Netscape 
Navigator check out the following Web page:
http://www.2meta.com/chats/
MindSpring provides a shareware version of Homer, an IRC program for the 
Macintosh.  With Homer, you can join several channels at the same time and 
switch between them easily, send a private message to anyone currently on the 
channel, put a picture of yourself in a window for others to see, and, if you have 
Apple PlainTalk speech software, you can hear the conversations spoken.
Homer is copyrighted shareware by Toby Smith.  If you want to continue using 
Homer beyond a thirty day trial period, you should pay the shareware fee to the 
program's author as described in the program's documentation.

Note:  MindSpring encourages you to register any shareware you decide to keep 
and use.  We've included this program in the package because we think it is the 
best Chat program available for the Macintosh.  There are other Chat programs 
available, which you may prefer to use rather than registering this shareware 
program.   



Launching Homer
From the PipeLine+ Access panel, connect to MindSpring, then click on the Homer
button on the Launch It! Toolbar.  
The first time you launch Homer, you will see an introductory message from the 
shareware author.  Read it, then click on Will do, chief.  After the splash screen 
(and sound), you will see a dialog box listing default server and user information.  
Go ahead and connect with this default information, just to learn how to connect.  
You can change the server or customize your user information later.  When you 
first sign on to a server, you will see only three of the following windows, and they 
will be stacked on top of each other (this is so they are accessible on smaller 
monitors).  The first thing you want to do is arrange them so you can see them.

Figure 21:  A sample layout of Homer windows 

Getting Started
The following sections explain basic IRC activities, such as:
· Signing on to a server
· Customizing Homer
· Finding and opening a channel
· Joining in



Signing On to a Server
Homer will not always be able to connect to the server currently named in the 
connection settings.  A server can be down or busy.  If Homer was not able to sign 
on to the current server, you can try the same one again (you can sometimes be 
successful even if you try just moments later), or you can try a different server.  
Select Start IRC Session from the Actions menu.  A dialog box displays briefly, 
telling you that Homer will attempt to connect to the current server.  
· To try the same server again, don’t click on anything.  After a few seconds, the

dialog box will close and Homer will start signing on.
· If you want to try a different server, click on the Click me to change the 

connection settings button.  Another dialog box displays, where you can 
enter the new server address (you can also enter new user information in 
this dialog box).  When you have entered the new address, click on the 
Connect button. 

Customizing Homer
There are lots of ways to customize Homer.  Here are a few:
· Enter or change your user ID, user name, and nickname.  Do this when you 

first sign on, by clicking the Click me to change the connection settings
button.  You would normally put your real name under User Name, and 
you can enter whatever you want under User ID and Nickname.  You’ll be
identified online primarily by your nickname.  In Homer’s User List 
window, your nickname will be followed by User ID@your address (User 
Name).  

· For example, if your name is Wanda Beebee, put that under User Name.  If 
you choose Wanda for your User ID and BeeBomb for your Nickname, 
and your MindSpring user name is wannabee, your entry in Homer’s User 
List window will look like this:

· BeeBomb  Wanda@wannabee.mindspring.com (Wanda Beebee)
· If the text is too small to read or so large that the windows won’t all fit on your

screen, select Font Size from the Options menu and select a different 
font.

· Rearrange the windows.  If you want to see the Faces window (where you can 
see pictures of some of the people on the channel), select Faces Window 
from the Windows menu.

· You have the option to turn off the sounds that play when you launch and quit 
Homer, by selecting Sound from the Options menu.

· To save any changes you make, select Save Prefs Now from the File menu.

Finding and Opening a Channel
You can find some information regarding channels on the Web sites named in this 
section, but these are just partial lists.  The total number of chat channels available 
is mind boggling.  Once you are signed on to a server, you can display a list of 
channels by typing /list, but beware, that list will go on forever.  To shorten the 
list, type /list -min 20 for a list of all channels that have at least 20 people on
them.  You can use any number you want, not just 20.
Once you have found a channel you want to try, open it.  Select New Channel from
the File menu, and type in the name of the channel, preceded by # (for example, 
#macintosh).

Joining In
When you first open a channel, you will see the text of a conversation that has 
already been established.  You may want to follow the conversation a bit prior to 
joining (this is called lurking).  If you have never been on a particular chat channel 
before, you may find that it is quite different from what the channel name implies.  
Even if you have been on a particular channel before, it may be quite different 
from the last time.  The character of a channel is usually determined by the people 
currently in conversation.



To join in, just start typing.  When you want to send what you have typed, press 
Return.  
When you are ready to leave a channel, select Close Channel from the File menu.

FAQs about Homer
What is a channel operator? What is an IRC operator?

A channel operator is someone with an @ symbol by their nickname in a /list, or an 
@ symbol by the channel name in /whois output.  Channel operators are 
kings/queens of their channel. This means they have full control over the channel, 
and can even kick you out of their channel for no reason. If you don't like this, you 
can start your own channel and become a channel operator there.  
An IRC operator is someone who maintains the IRC network.

What is a "bot"?
"Bot" is short for "robot". A bot generally tries to "protect" a channel.  It should be 
noted that many servers (especially in the United States) ban ALL bots.  Some ban 
bots so much that if you run a bot on their server, you will be banned from using 
that server.

What are some of the foreign language channels on IRC?  What do they mean?
Some of the most popular foreign language channels include #42 (which is a 
Finnish channel), #warung (which is a Malaysian channel; the word warung means 
coffeehouse or small restaurant), #polska (a Polish channel), #nippon (a Japanese 
channel, note that "funny" characters are often seen here -- this is Kanji. You will 



need a Kanji-compatible terminal program and Kanji-compatible IRC client to 
converse in Kanji), #espanol (a Spanish channel), #russian (a Russian channel). 
These are just examples -- a large percentage of the languages in the world is 
spoken on IRC somewhere.  If your language/country isn't listed above, you can try
to find it by asking on #irchelp.

Finding Help
Homer’s online help is available from the Apple menu, or ask for help on the 
#irchelp channel.
You can also find IRC help by checking out the following sites (type these URLs 
into Netscape Navigator’s Location field):
http://www.kei.com/irc.html
ftp.kei.com/pub/irc/alt-irc-faq



Using Fetch 
FTP (File Transfer Protocol) programs transfer files to and from FTP sites on the 
Internet.  MindSpring provides a licensed version of Fetch, an FTP program for the 
Macintosh.

Launching Fetch
From the PipeLine+ access panel, connect to MindSpring then click the Fetch icon 
on the Launch It! Toolbar. The New Connection dialog box appears, with 
MindSpring as the default host.

Figure 22:  New Connection dialog box

Getting Started
The first step is to connect to an FTP site.
· If you want to connect to MindSpring's ftp site to download MindSpring 

publications, don't change any of the field entries in the New Connection 
dialog box.

· If you want to connect to your own MindSpring-provided FTP site, enter your 
user ID and your password in the appropriate fields.  Delete “/pub” from 
the Directory field (the field should be blank).

· If you have the name of a machine you want to transfer files to or from, enter it
in the Host field and delete the entries from the other fields.

· For examples of machine names, see Fetch's Shortcut list (select Fetch 
Shortcuts from the Window menu).

· To connect to a machine on the Shortcuts list, click on the down arrow at the 
bottom of the New Connection window and scroll to the machine you 
want.

When you are ready to connect, click the OK button.  A transfer window appears, 
with the name of the machine you are connected to in the title bar.  The left side of 
the window resembles the standard Macintosh file selection dialog box.  Use this to
browse through directories and file lists.  You can also change to another directory 
using the Change Directory command from the Directories menu.



Downloading a File
Before you download a file, you may want to select a download location using the 
following steps:
· Select Preferences from the Customize menu.
· Click on the Download tab.
· Select Use Download Folder, then click on the button to the right to select a 

folder.
· Click on the OK button to save your settings.
Also, be sure the Automatic button at the bottom of the window is selected.  To 
download a file, find the file in the list, then double-click the filename.
The cursor turns into a running dog, letting you know that a Fetch is in progress.  
The right side of the window tells you the name and size of the file you are 
downloading, the number of bytes transferred, the transfer rate (bytes/second), and 
the time remaining (also represented by a clock).

Uploading a File
Generally, you won't be able to upload to a machine unless you have "write" 
privileges for the machine or for a directory on the machine.  You have this 
privilege on your MindSpring-provided sites.



To upload a file, follow these steps:
· Access the directory to which you want to upload, and click the Put File 

button.  A standard file selection dialog box displays.  
· Find the file you want to upload, then double-click the file name.  Another 

dialog box displays where you select the upload format.  There are six 
different formats.  Each encodes your file in a different way, except Raw 
Data, which transfers the file without encoding.  Refer to Fetch Help for 
more information on encoding formats.  Fetch adds the appropriate suffix 
to your file name, if any.  

· To begin uploading, click the OK button.  The cursor turns into a running dog, 
and the right side of the window displays the progress of the upload.

Deleting a File
To delete a file from a directory (again, you will need "write" privilege to do this), 
follow these steps: 
· Select the file you want to delete. 
· Select Delete Directory or File from the Remote menu.  You will be 

prompted to make sure you want to delete the selected file(s).

Finding Help
Fetch has online help, which you can view by selecting Fetch Help from the 
Windows menu.
Fetch also uses balloon help.  You can turn it on long enough to answer your 
questions, then turn it off again.
To check out the Fetch Web page, type this URL into Netscape's Go To field:
http://www.dartmouth.edu/pages/softdev/fetch.html



Using StuffIt Expander
Most files you download from the Internet are compressed and/or encoded.  To use 
these files after you download them, you’ll need a program that can expand and 
decode files set up as a “helper application” in Netscape Navigator, Anarchie, or 
whatever software you are using to download from the Internet.  MindSpring 
provides a freeware version of StuffIt Expander, a program that can expand and 
decode most files you download to your Macintosh.
With StuffIt Expander, you can expand files that were compressed with the two 
most common Macintosh archive formats, StuffIt (.sit) and Compact Pro (.cpt).  
You can also decode files that were encoded with the common Macintosh encoding
formats, BinHex (.hqx) and MacBinary (.bin).
This section introduces StuffIt Expander, a decompression/decoding program that 
can expand most compressed files on the Macintosh, as well as decode BinHex or 
MacBinary encoded files.  

Launching StuffIt Expander
From the Finder, you can double-click the StuffIt Expander icon to launch the 
program.  If you have System 7.x, you can launch the program and automatically 
expand/decode a file by dragging the icon of the file you want to expand to the 
StuffIt Expander program icon.

Figure 23:  The StuffIt Expander progress window

Getting Started
From StuffIt Expander, choose any of the following suggestions to get started:
· Most of the time, StuffIt Expander will work automatically, in the background,

when you download files from the Internet.  
· If you have a file on disk that you want to expand or decode, drag the file to 

the StuffIt Expander icon, or launch StuffIt Expander, select Expand from
the File menu, locate your file in the standard Macintosh file dialog box, 
then click on Expand.  StuffIt Expander will expand and decode the file, 
and save the resulting file to the same folder.

FAQs about StuffIt Expander
I have a file with “.sit.hqx” at the end of it.  What does that mean?

It means that the file is both compressed (StuffIt archive) and encoded (BinHex).  
If you drag the file icon to the StuffIt Expander icon, StuffIt Expander will both de-
binhex it and expand it, leaving you with a file that’s ready to use.

Sometimes StuffIt saves more than one file when it expands.  What are those extra files?
If you expand a file that is both compressed and encoded, StuffIt saves the 
intermediary files along with the final, expanded file.  For example, if you expand 
marmalade.jpg.sit.hqx, StuffIt will save marmalade.jpg.sit after de-binhexing, and 
marmalade.jpg after expanding.



I downloaded a file with “.uu” at the end of it, and StuffIt Expander didn’t do anything with it.  
What should I do?

The .uu extension means the file is UUencoded.  StuffIt Expander can’t decode 
UUencoded files, but you can download DropStuff with Expander Enhancer, a 
shareware product that enables StuffIt Expander to decode .uu and other files.  See 
the following section for more information.

Finding Help and Product Information
StuffIt Expander documentation is in the Read Us First! folder in the StuffIt 
Expander folder.
You can find more information about StuffIt Expander and other Aladdin Systems 
products at the following Web site (type this URL into Netscape Navigator’s 
Location field):
http://www.aladdinsys.com/
Click on the Shareware/Freeware Products link to find information about StuffIt 
Expander, or to download DropStuff with Expander Enhancer, a shareware product 
that adds functionality to StuffIt Expander, enabling it to expand most compressed 
files you find on the Internet, including .zip, .gz, and .uu.



Using JPEGView
To view the graphics you find on the Internet, you will need a graphics viewer set 
up as a “helper application” in Netscape Navigator or your other primary Internet 
applications.  You will also need a graphics viewer if you want to download 
graphics and view them while you are offline.  MindSpring provides a 
postcardware version of JPEGView, a versatile graphics viewer for the Macintosh. 
that can read PICT, GIF, TIFF, BMP, MacPaint, and Startup Screen files as well as 
JPEG (JFIF) files.

Launching JPEGView
From the Finder, double-click the JPEGView icon to launch the program, or 
double-click on the icon of the graphics file you want to open or drag the graphics 
file to the JPEGView icon to view the file.

Figure 24: JPEGView windows

JPEGView lets you:
· Crop an area to view alone or save as a new file
· Select and copy parts of images to insert into other files, such as desktop 

publishing files
· Save an image in several different formats, including PICT Resource (which 

you can use as a startup screen)
· Save all or part of an image to use as the file’s icon (a nifty feature that will 

help you identify files without opening them, or create custom icons to 
copy to other files)

· Create your own slide show



Getting Started
From JPEGView, choose any of the following suggestions to get started:
· To open a file, select Open from the File menu.  If the file name doesn’t 

display in the dialog box (even though you are in the right folder), click on
the Scan for Image Files button.  If that doesn’t work, try selecting 
Import from the File menu.  This will display all files in the selected 
folder, regardless of type.

· Try the various options on the View menu to see the image in different sizes.  
You can view an image full screen, zoomed in, or zoomed out.

· Drag your cursor around part of the image then select Crop & Zoom from the 
Edit menu.  Each time you crop & zoom, JPEGView creates a new 
window for the cropped image.

· To set up a slide show, select Slide Show Options from the File menu.  For 
complete slide show instructions, see the Slide Show section of 
JPEGView’s online help, accessible from the Help/Guide menu.

· To create a custom icon for a file, select Save As from the File menu, be sure 
Create custom Finder icons is selected, rename the file if you want, then
click on Save.

Finding Help
JPEGView has great online help that tells you more than you want to know about 
how graphic (and video) images are displayed on your screen.  You can access 
JPEGView’s online help by selecting JPEGView Help from the /  menu.



Using SoundMachine
To play sound files you find on the Internet, you’ll need a sound file player set up 
as a “helper application” in Netscape Navigator or your other primary Internet 
applications.  You will also need a sound file player if you want to download sound
files and play them while you are offline.  MindSpring provides a reduced fee 
shareware version of SoundMachine, a sound file player for the Macintosh.
SoundMachine is copyrighted shareware by Rod Kennedy.  If you want to continue
using SoundMachine beyond a thirty day trial period, you should pay the shareware
fee to the program's author as described in the program's documentation.

Note:  MindSpring encourages you to register any shareware you decide to keep 
and use.  We've included this program in the package because we think it is the 
best sound player available.  There are other sound players available, which you 
may prefer to use rather than registering this shareware program.   

SoundMachine can play .au, .aiff, .aifc, and .wav sound files, plus Mac sound 
resources and Finder sound files.  With SoundMachine, you can also record sounds 
from audio CDs (if you have a CD-ROM drive), and convert some sound files into 
sounds you can play through your Finder.

Launching SoundMachine
From the Finder, you can double-click the SoundMachine icon to launch the 
program.  If you have System 7.x, you can launch the program and automatically 
play a sound file by dragging the icon of the sound file you want to play to the 
SoundMachine program icon.

Figure 25:  The SoundMachine Player window

Getting Started
From SoundMachine, choose any of the following suggestions to get started:
· The first time you launch SoundMachine, you will have to personalize your 

copy of the program by entering your name and affiliation on the 
registration screen. If you don’t have a company name, or don’t know 
what to put for affiliation, you can enter anything you want (but you will 
have to enter something).

· If the Player window does not display, select Player Window from the 
Window menu.  The Player window should look familiar; it has many of 
the same controls as an audio tape or CD player.

· To open and play a single sound file, select Open from the File menu.  You 
can then use the controls in the Player window to play the file.

· To create a list of sound files to open and play, use the Queue window.  Use 
balloon help or the SoundMachine manual to learn how to use the Queue 
window.  See the Finding Help section for information about the 
SoundMachine manual.

· See the SoundMachine manual for full instructions on recording sound files 
from audio CDs.

FAQ about SoundMachine

I have a sound file called “twee.au.sit”, but SoundMachine can’t play it.  What should I do?
The .au extension indicates that it is a sound file that SoundMachine can play, and 
the .sit extension indicates that the file is compressed as a StuffIt archive.  Use 



StuffIt Expander to expand twee.au.sit, then you can play twee.au with 
SoundMachine.  See the Using StuffIt Expander, on page 126, for instructions.

Finding Help
SoundMachine uses balloon help, which you can turn on from the Help/Guide 
menu.  
The PipeLine+ package includes a manual for SoundMachine, which you can view 
with Adobe’s Acrobat Reader.  You can download a free copy of Acrobat Reader, 
as an introduction to Acrobat, from the following Web site (type this URL into 
Netscape Navigator’s Location field):
http://www.adobe.com/prodindex/acrobat/main.html
The SoundMachine user guide is in the SoundMachine folder (SoundMachine 
Manual.pdf).  Once you have downloaded Acrobat Reader, just double-click on the 
SoundMachine Manual icon to view it.
To keep up with the latest versions of SoundMachine, go to the following Web site:
http://www.kagi.com/rod
The SoundMachine site has links to other sites where you can find sound files, 
including the ever-popular Capt. James T. Kirk Sing-a-long Page (which also 
includes sound bites from Spock, Uhura, and Data):
http://www.loskene.com/singalong/kirk.html

Glossary of Terms

56K line
A digital phone-line connection (leased line) capable of carrying 56,000 bits-per-
second. At this speed, a Megabyte will take about 3 minutes to transfer. This is 4 
times as fast as a 14,400bps modem. 

Archie
A tool (software) for finding files stored on anonymous FTP sites. You will need to
know the exact filename or a sub-string within it.

ASCII - American Standard Code for Information Interchange
This is the de facto world-wide standard for the code numbers used by computers to
represent all the upper- and lower-case Latin letters, numbers, punctuation, etc. 
There are 128 standard ASCII codes, each of which can be represented by a 7 digit 
binary number: 0000000 through 1111111.

backbone
A high-speed line or series of connections that forms a major pathway within a 
network. The term is relative, as a backbone in a small network will likely be much
smaller than many non-backbone lines in a large network.

bandwidth
How much "stuff" you can send through a connection. Usually measured in bits-
per-second. A full page of English text is about 16,000 bits. A standard modem (by 
1995 standards) can move about 15,000 bits in one second. Full-motion full-screen 
video would require roughly 10,000,000 bits-per-second, depending on 
compression.

BBS - Bulletin Board System
A computerized meeting and announcement system that allows people to carry on 
discussions, upload and download files, and make announcements without the 
people being connected to the computer at the same time. There are many 
thousands (millions?) of BBSs around the world. Most are very small, running on a 



single IBM clone PC with 1 or 2 phone lines.  The line between a BBS and a 
system like CompuServe gets crossed at some point, but it is not clearly drawn.

BinHex - BINary HEXadecimal
A method for converting non-text files (non-ASCII) into ASCII. This is needed 
because Internet e-mail can only handle ASCII.

bit - Binary Digit
A single digit number in base-2 -- in other words, either a one or a zero. The 
smallest unit of computerized data. Bandwidth is usually measured in bits-per-
second.

BITNET - Because It's Time Network
A network of educational sites separate from the Internet, but e-mail is freely 
exchanged between BITNET and the Internet. Listservs, the most popular form of 
e-mail based discussion groups, originated on BITNET. BITNET machines are 
IBM VMS machines, and the network is probably the only international network 
that is shrinking.

browser
A client program (software) that is used to look at various kinds of Internet 
resources.

byte
A set of bits that represent a single character. Usually there are 8 or 10 bits in a 
byte, depending on how the measurement is being made.

client
A software program that is used to contact and obtain data from a server software 
program on another computer, often across a great distance. Each client program is 
designed to work with one or more specific kinds of server programs, and each 
server requires a specific kind of client. 

cyberspace
A term originated by author William Gibson in his novel Neuromancer, the word 
cyberspace is currently used to describe the whole range of information resources 
available through computer networks.

domain name
· The unique name that identifies an Internet site. Domain names always have 2 

or more parts, separated by dots. The part on the left is the most specific, and 
the part on the right is the most general. A given machine may have more than 
one domain name but a given domain name points to only one machine.  
Usually, all of the machines on a given network will have the same thing as the
right-hand portion of their domain names,  e.g. 

· gateway.gbnetwork.com
· mail.gbnetwork.com
· www.gbnetwork.com
It is also possible for a domain name to exist but not be connected to an actual 
machine.  This is often done so that a group or business can have an Internet e-mail
address without having to establish a real Internet site.  In these cases, some real 
Internet machine must handle the mail on behalf of the listed domain name.

e-mail - electronic mail
Messages, usually text, sent from one person to another via computer.  E-mail can 
also be sent automatically to a large number of addresses (mailing list).



ethernet
A very common method of networking computers in a LAN. Ethernet will handle 
about 10,000,000 bits-per-second and can be used with almost any kind of 
computer. 

FAQs - Frequently Asked Questions
FAQs are documents that list and answer the most common questions on a 
particular subject.  There are hundreds of FAQs on subjects as diverse as Pet 
Grooming and Cryptography.  FAQs are usually written by people who have tired 
of answering the same question over and over, or are trying to speed up the 
education process for new users.

FDDI - Fiber Distributed Data Interface
A standard for transmitting data on optical fiber cables at a rate of around 
100,000,000 bits-per-second (10 time as fast as Ethernet, about twice as fast as T-
3).

FTP - File Transfer Protocol
A very common method of moving files between two Internet sites.  FTP is a 
special way to login to another Internet site for the purposes of retrieving and/or 
sending files.  There are many Internet sites that have established publicly 
accessible repositories of material that can be obtained using FTP, by logging in 
using the account name "anonymous" and your e-mail address as the password.  
These sites are called "anonymous ftp servers".

finger
An Internet software tool for locating people on other Internet sites.  Finger is also 
sometimes used to give access to non-personal information, but the most common 
use is to see if a person has an account at a particular Internet site.  There are some 
sites do not allow incoming finger requests.

gateway
The technical meaning is a hardware or software set-up that translates between two 
dissimilar protocols, for example Prodigy has a gateway that translates between its 
internal, proprietary e-mail format and Internet e-mail format.  Another, sloppier 
meaning of gateway is to describe any mechanism for providing access to another 
system, e.g. AOL might be called a gateway to the Internet.

gopher
A widely successful method of making menus of material available over the 
Internet.  Gopher is a client-and-server style program, which requires that the user 
have a gopher client program.  Although gopher spread rapidly across the globe in 
only a couple of years, it is being largely supplanted by hypertext, also known as 
WWW (World Wide Web).  There are still thousands of gopher servers on the 
Internet and we can expect they will remain for a while. 

host
Any computer on a network that is a repository for services available to other 
computers on the network.  It is quite common to have one host machine provide 
several services, such as WWW and USENET news.  

HTML - HyperText Markup Language
The coding language used create hypertext documents for use on the World Wide 
Web.  HTML looks a lot like old-fashioned typesetting code, where you surround a
block of text with codes that indicate how it should appear.  Additionally, in 
HTML you can specify that a block of text, or  a word, is "linked" to another file 
on the Internet.  HTML files are meant to be viewed using a World Wide Web 
client program, such as Netscape.  



HTTP - HyperText Transport Protocol
The protocol for moving hypertext files across the Internet.  Requires a HTTP 
client program on one end, and an HTTP server program on the other end.  HTTP 
is the most important protocol used in the World Wide Web (WWW).

hyperlink
A hyperlink is a logical link between two related pieces of information in 
WEBspace.  It allows a browsing user the ability to rapidly jump from idea to idea 
in a non-linear motion.  It is at the core of hypertext technology, and closely 
mimics the way humans think.

hypertext
Generally, any text that contains "links" to other documents - words or phrases in 
the document that can be chosen by a reader and which cause another document to 
be retrieved and displayed.

IMHO - In My Humble Opinion
A shorthand appended to a comment written in an online forum, IMHO indicates 
that the writer is aware that they are expressing a debatable view, probably on a 
subject already under discussion.  One of many such shorthands in common use 
online, especially in discussion forums.

IP - Internet Protocol
The Internet standard protocol that provides a common layer over dissimilar 
networks, used to move packets among host computers and through gateways if 
necessary. 

IP address
The numeric address of a computer connected to the Internet; also called Internet 
address. 

IP number
Sometimes called a "dotted quad".  A unique number consisting of 4 parts 
separated by dots, e.g. 165.113.245.2
This can either be a predetermined number (static) or a different one can be 
assigned each time you login (dynamic).
Every machine that is on the Internet has a unique IP number.  Most machines also 
have one or more domain names that are easier for people to remember.

IRC - Internet Relay Chat
Basically a huge multi-user live chat facility.  There are a number major IRC 
servers around the world which are linked to each other.  Anyone can create a 
"channel" and anything that anyone types in a given channel is seen by all others in
the channel.  Private channels can (and are) created for multi-person "conference 
calls".

ISDN - Integrated Services Digital Network
Basically a way to move more data over existing regular phone lines.  ISDN is only
slowly becoming available in the USA but where it is available, it can provide 
speeds of 64,000 bits-per-second over a regular phone line at almost the same cost 
as a normal phone call.

Internet (uppercase I)
The vast collection of inter-connected networks that all use the TCP/IP protocols 
and that evolved from the ARPANET of the late 60s and early 70s.  The Internet 
now (July 1995) connects roughly 60,000 independent networks into a vast global 
Internet.



internet (lowercase i)
Any time you connect two or more networks together, you have an internet - as in 
inter-national or inter-state.

kilobyte
A thousand bytes.  Actually, usually, 1024 (210) bytes. 

LAN -  Local Area Network
A computer network limited to the immediate area, usually the same building or 
floor of the building.

leased-line
Refers to a phone line that is rented for exclusive 24-hour, 7-days-a-week use from 
your location to another location.  The highest speed data connections require a 
leased line.  

listserv
The most common kind of maillist , listservs originated on BITNET but they are 
now common on the Internet. 

login
noun: The account name used to gain access to a computer system.
verb: The act of entering into a computer system, e.g. "Login  to MindSpring and 
check your e-mail." 

megabyte (MB)
A million bytes.  A thousand kilobytes. 

MOO - MUD, Object Oriented
One of several kinds of multi-user role-playing environments, so far only text-
based.

MUD - Multi-User Dungeon or Dimension
A (usually text-based) multi-user simulation environment.  Some are purely for fun 
and flirting, others are used for serious software development, or education 
purposes and all that lies in between.  A significant feature of most MUDs is that 
users can create things that stay after they leave and which other users can interact 
with in their absence, thus allowing a "world" to be built gradually and collectively.

MUSE
One kind of MUD - usually with little or no violence.  See also: MOO, MUD

maillist (or mailing list)
A (usually automated) system that allows people to send e-mail to one address, 
whereupon their message is copied and sent to all of the other subscribers to the 
maillist.  In this way, people who have many different kinds of e-mail access can 
participate in discussions together.

modem - MOdulator, DEModulator
A device that you connect to your computer and to a phone line, that allows the 
computer to talk to other computers through the phone system.  Basically, modems 
do for computers what a telephone does for humans.

Mosaic
The first WWW browser that was available for the Macintosh, Windows and UNIX
all with the same interface.  "Mosaic" really started the popularity of the Web.  The



source-code to Mosaic has been licensed by several companies and there are 
several other pieces of software as good or better than Mosaic, most  notably 
"Netscape".  See also: browser, client, WWW

NIC or InterNIC - Network Information Center
Generally, any office that handles information for a network.  The most famous of 
these on the Internet is the InterNIC, which is where new domain names are 
registered.

network
Any time you connected 2 or more computers together so that they can share 
resources you have a computer network.  Connect 2 or more networks together and 
you have an internet.  See also: Internet, internet

newsgroups
The name for discussion groups on Usenet.  See also: Usenet

node
Any single computer connected to a network.  See also: network, Internet, internet

packet switching
The method used to move data around on the Internet.  In packet switching, all the 
data coming out of a machine is broken up into chunks.  Each chunk has the 
address from where it came and to where it is going.  This enables chunks of data 
from many different sources to commingle on the same lines, and be sorted and 
directed to different routes by special machines along the way.  In this way many 
people can use the same lines at the same time.

password
A code used to gain access to a locked system.  Good passwords contain letters and
non-letters and are not simple combinations such as virtue7.  A good password 
might be: Hot$l-6.  See also: login

port - (3 meanings)
First and most generally, a place where information goes into or out of a computer, 
or both. e.g. the "serial port" on a personal computer is where a modem would be 
connected.
On the Internet, port often refers to a number that is part of a URL, appearing after
a colon (:) right after the domain name.  Every service on an Internet server 
"listens" on a particular port number on that server.  Most services have standard 
port number, e.g. Web servers normally listen on port 80.  Services can also listen 
on non-standard ports, in which case the port number must be specified in a URL 
when accessing the server, so you might see a URL of the form:

gopher://peg.cwis.uci.edu:7000/
which shows a gopher server running on a non-standard port (the standard gopher 
port is 70).
Finally, port also refers to translating a piece of software to bring it from one type 
of computer system to another, e.g. to translate a Windows program so that it will 
run on a Macintosh.
See also: domain name, server, URL

PPP - Point to Point Protocol
Most well known as a protocol that allows a computer to use a regular telephone 
line and a modem to make a TCP/IP connection and thus be really and truly on the 
Internet.  PPP is gradually replacing SLIP for this purpose.  See also: IP number, 
Internet, SLIP, TCP/IP



protocol
A mutually determined set of formats and procedures governing the exchange of 
information between systems.

remote access
The ability to access a computer from outside a building in which it is housed, or 
outside the library.  Remote access requires communications hardware, software, 
and actual physical links, although this can be as simple as common carrier 
(telephone) lines or as complex as telnet login to another computer across the 
Internet. 

RFC - Request For Comments
The name of the result and the process for creating a standard on the Internet. New 
standards are proposed and published on line, as a Request For Comments.  The 
Internet Engineering Task Force is a consensus-building body that facilitates 
discussion, and eventually a new standard is established, but the reference 
number/name for the standard retains the acronym RFC, e.g. the official standard 
for e-mail is RFC 822.

router
A special-purpose computer (or software package) that handles the connection 
between 2 or more networks.  Routers spend all their time looking at the 
destination addresses of the packets passing through them and deciding which route
to send them on.  See also: network, packet switching

SMDS - Switched Multimegabit Data Service
A new standard for very high-speed data transfer.

server
A computer, or a software package, that provides a specific kind of service to client
software running on other computers.  The term can refer to a particular piece of 
software, such as a WWW server, or to the machine on which the software is 
running, e.g. "Our mail server is down today, that's why e-mail isn't getting out."  A
single server machine could have several different server software packages 
running on it, thus providing many different services to clients on the network.  See
also: client, network

shareware
Microcomputer software, distributed through public domain channels.  There is no 
fee to obtain the software and try it out, but the author expects to receive 
compensation if you decide to use it.  The trial period is usually 30 days, but is 
arbitrarily set by the author.

SLIP - Serial Line Internet Protocol
A standard for using a regular telephone line (a "serial line") and a modem to 
connect a computer as a real Internet site.  SLIP is gradually being replaced by 
PPP.  See also: Internet, PPP

T-1
A leased-line connection capable of carrying data at 1,544,000 bits -per-second. At 
maximum theoretical capacity, a T-1 line could move a megabyte in less than 10 
seconds.  That is still not fast enough for full-screen, full-motion video, for which 
you need at least 10,000,000 bits-per-second.  T-1 is the fastest speed commonly 
used to connect networks to the Internet.
See also: 56K, bandwidth, bit, byte, ethernet, T-3



T-3
A leased-line connection capable of carrying data at 45,000,000 bits-per-second.  
This is more than enough to do full-screen, full-motion video.
See also: 56K, bandwidth, bit, byte, ethernet, T-1

TCP/IP - Transmission Control Protocol/Internet Protocol
This is the suite of protocols that defines The Internet.  Originally designed for the 
UNIX operating system, TCP/IP software is now  available for every major kind of 
computer operating system.  To be truly on the Internet, your computer must have 
TCP/IP software.  See also: IP number, Internet, UNIX

telnet
A command and program used to login from one Internet site to another.  The 
telnet command/program gets you to the login: prompt of another host.

terminal
A device that allows you to send commands to a computer somewhere else.  At a 
minimum, this usually means a keyboard and a display screen and some simple 
circuitry. usually you will use terminal software in a personal computer - the 
software pretends to be ("emulates") a physical terminal and allows you  to type 
commands to a computer somewhere else.

terminal emulation
Most communications software packages will permit your personal computer or 
workstation to communicate with another computer or network as if it were a 
specific type of terminal directly connected to that computer or network.

terminal server
A special purpose computer that has places to plug in many modems on one side, 
and a connection to a LAN or host machine on the other side.  Thus the terminal 
server does the work of answering the calls and passes the connections on to the 
appropriate node.  Most terminal servers can provide PPP or SLIP services if 
connected to the Internet.
See also: LAN, modem, host, node, PPP, SLIP

UNIX
A computer operating system (the basic software running on a computer, 
underneath things like word processors and spreadsheets).  UNIX is designed to be 
used by many people at the same time (it is "multi-user") and has TCP/IP built-in.  
It is the most common operating system for servers on the Internet.

URL -  Uniform Resource Locator
The standard way to give the address of any resource on the Internet. A URL looks 
like this:
http://www.mindspring.com/index.html or telnet://well.sf.ca.us or 
news:new.newusers.questions
The most common way to use a URL is to enter into a WWW browser, such as 
Netscape.  See also: browser, WWW

Usenet
A world-wide system of discussion groups, with comments passed among hundreds
of thousands of machines.  Not all Usenet machines are on the Internet, maybe half.
Usenet is completely decentralized, with over 20,000 discussion areas, called 
newsgroups.  See also: newsgroup

UUCP - Unix to Unix Copy
A batch-oriented "store and forward" protocol for sending files, mail, and news 
between UUCP interconnected computers.  UUCP hosts are not connected full 
time.  They typically call up once or several times a day to retrieve mail and news, 
as well as send any queued local mail.  UUCP was very popular before widespread 



Internet connectivity was common.  It still is an inexpensive way to handle mail 
and news. 

Veronica - Very Easy Rodent Oriented Net-wide Index to Computerized Archives
Developed at the University of Nevada, Veronica is a constantly updated database 
of the names of almost every menu item on thousands of gopher servers.  The 
Veronica database can be searched from most major gopher menus.  See also: 
gopher

WAIS - Wide Area Information Servers
A commercial software package that allows the indexing of huge quantities of 
information, and then making those indices searchable across networks such as the 
Internet.  A prominent feature of WAIS is that the search results are ranked 
("scored") according to how relevant the "hits" are, and that subsequent searches 
can find "more stuff like that last batch" and thus refine the search process.

WAN - Wide Area Network
Any internet or network that covers an area larger than a single building or campus.
See also: Internet, internet, LAN, network

WWW - World Wide Web
First, loosely used:  The whole constellation of resources that can be accessed using
gopher, FTP, HTTP, telnet, Usenet, WAIS, and some other tools. Second, the 
universe of hypertext servers (HTTP servers) which are the servers that allow text, 
graphics, sound files, etc., to be mixed together.
See also: browsers, FTP, gopher, HTTP, telnet, URL, WAIS





Service Agreement
MINDSPRING ENTERPRISES, INC. SERVICE AGREEMENT

If I have given my credit card number to MindSpring, I understand that charges will be billed to my credit card 
each month for the basic service and any additional usage. I authorize this automatic billing by MindSpring.  
MindSpring's monthly billing cycle is based on my sign-up date, with the basic service fee for each month 
charged at the beginning of my billing cycle along with additional usage fees from the previous billing cycle. I 
understand that I am responsible for determining whether a MindSpring phone number is within my local 
calling area, and that I am responsible for any long distance charges I may incur in connecting to MindSpring. 
If I am using one of MindSpring’s unlimited plans, I agree not to provide any public information services over 
this connection, not to use any automatic method to avoid inactivity disconnect, and to keep the connection 
active only when I am actively using it.  I understand that I may cancel my account at any time effective the 
end of that billing cycle. If I am not satisfied and wish to cancel my account within 30 days of the day 
MindSpring activates my account, I may do so and receive a full refund of all money paid by returning all  
MindSpring startup materials in good condition within those first 30 days and signing a statement certifying 
that I have kept no copies of any of the MindSpring startup materials, either software or hardcopy. I understand
that MindSpring may change its prices from time to time, and that I will be provided with 15 days written or 
electronic mail notice of any such changes.
I agree to maintain my password as private and confidential information. I agree to use my MindSpring account
in a way that conforms with all applicable laws and regulations.  I specifically agree not to make any attempt to
gain unauthorized access to any other systems or networks. I understand that the information available through 
MindSpring or interconnecting networks may not be accurate.  I understand that the some of the information 
available through MindSpring or interconnecting networks may be intended for adult audiences. I understand 
that internetworking communications are not secure, and may be subject to interception or loss. MindSpring 
Enterprises, Inc. makes no warranties of any kind, either express, implied, or statutory concerning the data or 
information available through the MindSpring network. I understand that the use of my MindSpring account, 
and any data or information accessed using that account, will be completely at my own risk.  I understand that 
the cumulative liability of MindSpring for any and all claims relating to the services provided by MindSpring, 
in contract, tort, or otherwise, shall not exceed the total amount of the basic service fees paid to MindSpring for
services within the prior year.  I agree that MindSpring shall have no liability for the services, data or 
information  made available to me, including any liability for any consequential, indirect, special or incidental 
damages regardless of the success or effectiveness of other remedies. I understand that MindSpring reserves the
right to terminate my account at any time, for any reason, including, but not limited to, my failure to abide by 
the terms of this agreement or my failure to pay any fees or charges when due. I understand that violation of 
certain generally accepted guidelines on Internet usage, such as restrictions on mass e-mailings and mass 
advertising, or posting to inappropriate newsgroups, may cause severe operating difficulties for MindSpring, 
and would be a likely cause for the termination of my account.  More detail of violations referenced can be 
found in the MindSpring Policy on Appropriate Use.  This Policy can be found linked from the MindSpring 
Home Page at  http://www.mindspring.com/ on the World Wide Web.
This agreement represents the complete agreement between MindSpring Enterprises, Inc., and myself, and 
supersedes  any other written or oral agreement.  The terms of this agreement may only be changed in writing 
and any changes must be signed by both MindSpring and myself to be effective.

MindSpring Enterprises, Inc.
1430 West Peachtree St. NW, Suite 400, Atlanta, GA  30309

(404) 815-0082 · (800) 719-4332
http://www.mindspring.com/
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